Tutorial
## Table of Contents

**Introduction** 7

**Chapter 1: Getting Started** 9
   - Chapter Summary 9
   - Before Starting the Tutorial 9

**Chapter 2: New View and Manipulating Report Data** 11
   - Logging on to Analyst 11
   - Creating a New View 11
   - Recalculating, Saving, and Resetting 13
   - Saving the Excel Report 15

**Chapter 3: Dynamic Selections** 17
   - Detailed Selection using Entire Cube and Saved Selection 17
   - Setting up a Saved Selection in Analyst 18
   - Delete, Rename, Add and Sort Items 20

**Chapter 4: Multiple Views on a Single Page** 23
   - Displaying Multiple Views on A Single Page 23
   - Simultaneous Page Scrolling 24
   - Refreshing Views 25
   - Running a D-Link 26

**Chapter 5: Creating a Pivot View** 29

**Chapter 6: Hierarchical Views** 31
   - Creating a Hierarchical View 31
   - Inserting Custom Items 33

**Chapter 7: Updating an Existing Report** 35
   - Renaming the D-Cube 35
   - Changing and Deleting D-List Items 36
   - Inserting Items into an Existing Subtotal 36
   - Reordering D-Lists 37
   - Refreshing a View 37
   - Replacing the D-Cube Name 38
   - Updating the Row, Column, and Page Labels 38
   - Renaming and Deleting D-List Items 39
   - Inserting New D-List Items 39
   - Sorting D-List Items 40
   - Batch Printing Data 40
      - Creating a New View 40
      - Batch Printing Selected Data 41
   - Printing the Report 43

---

Licensed Materials – Property of IBM
© Copyright IBM Corp. 2003, 2010.
# Table of Contents

**Chapter 8: Defining a View**  
45

**Chapter 9: Using Analyst Options**  
49

- Access the Analyst View Options dialog box  
49
- Using Formatting Options  
49
  - Auto Color - Foreground Data Cells  
49
  - Auto Color - Background Data Cells  
50
  - Auto Color - Foreground D-List Cells  
52
  - Auto Color - Background D-List Cells  
52
- Replicate Headings  
53
- Suppress Zero Rows On Refresh  
53

- Using Advanced Options  
54
  - Treat Blank Cells as Zero on Recalculate  
54
  - Treat Errors as Zero on Recalculate  
55
  - Allow Break-back on Recalculate  
55
  - Allow Break-back from Excel Formula  
55
  - Overwrite Excel formula on refresh  
56
  - Blank invalid data cells if note present  
56
  - Validity Checks  
56
  - Check for Unmatched Items  
56
  - Check for Incomplete Totals  
57

- Action on Opening Workbook  
58
  - Refresh View on Loading  
58
  - Get Write Access on Loading  
58

**Appendix A: The Analyst Menu in Excel**  
59

- Refresh  
59
  - Refresh Views of D-Cube  
59
  - Refresh Selected View  
59
  - Refresh All Views  
59

- Recalculate  
60
  - Recalculation Rules  
60
  - Recalculate Selected View  
60
  - Recalculate All Views  
61

- Reselect View  
61
- Save D-Cube  
61
- Reset D-Cube  
61
- Read Write Access  
62
- Batch Printing  
62
  - Print Sheets  
62

- Drill Down  
62
- Pick Item from D-List  
63
- Run Macro  
63
- Run D-Link  
63
- New View  
63
  - Additional View Options for New Views  
63
- Views  
63
  - Copy Views  
63
  - Delete Views  
64
Display Options for Views 64
Define View 64
Auditing 65
   Check View for renamed D-List items 65
   Show Precedents of Formula 66
   Check Integrity of Views 66
   Check Active View for Errors 66
   Check Active View for Blanks 66
   Replace object names in all definitions 66
Assign Action 67
   Refresh 67
   Recalculate 67
   Get Write Access 67
   Release Write Access 67
   Save 67
   Print 67
   Run Macro 68
   Run D-Link 68
   Log On 68
   Log Off 68
   Options 68
   Help 68
   About 68

Appendix B: Reference 69
   Inserting Rows or Columns as the First or Last Item in the List 69
   Laminated Dimensions 69
   Page Label Drop-Down Menu 69
   Sharing Pages 70
   Analyst Macro List 70
   Visual Basic Commands 71
   Print Macros 71

Index 73
Table of Contents
This document is intended for use with IBM® Cognos® 8 Planning - Analyst.

This tutorial provides you with an overview of what Analyst for Microsoft® Excel can do. After you complete the tutorial, you will be able to produce tables and reports made for your needs. The entire tutorial should take only a few hours to complete.

IBM Cognos 8 Planning provides the ability to plan, budget, and forecast in a collaborative, secure manner. The major components are Analyst and Contributor.

**IBM Cognos 8 Planning - Analyst**

Analyst is a flexible tool used by financial specialists to define their business models. These models include the drivers and content required for planning, budgeting, and forecasting. The models can then be distributed to managers using the Web-based architecture of IBM Cognos 8 Planning - Contributor.

**IBM Cognos 8 Planning - Contributor**

Contributor streamlines data collection and workflow management. It eliminates the problems of errors, version control, and timeliness that are characteristic of a planning system solely based on spreadsheets. Users have the option to submit information simultaneously through a simple Web or Microsoft® Excel interface. Using an intranet or secure Internet connection, users review only what they need to review and add data where they are authorized.

For more information about using this product, visit the IBM Cognos Resource Center (http://www.ibm.com/software/data/support/cognos_crc.html).

**Best Practices for IBM Cognos 8 Planning**

The Cognos Innovation Center™ for Performance Management provides a forum and Performance Blueprints that you can use to discover new ideas and solutions for finance and performance management issues. Blueprints are pre-defined data, process, and policy models that incorporate best practice knowledge from customers and the Cognos Innovation Center. These Blueprints are free of charge to existing customers or Platinum and Gold partners. For more information about the Cognos Innovation Center or the Performance Blueprints, visit http://www.cognos.com/innovationcenter.

**Audience**

To use this guide, you should have completed the Analyst Tutorial, and have some knowledge of spreadsheets.

**Finding Information**

Product documentation is available in online help from the Help menu or button in IBM Cognos products.
To find the most current product documentation, including all localized documentation and knowledge base materials, access the IBM Cognos Resource Center (http://www.ibm.com/software/data/support/cognos_crc.html).

You can also read PDF versions of the product readme files and installation guides directly from IBM Cognos product CDs.

**Samples Disclaimer**

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample, depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values, is coincidental. Unauthorized duplication is prohibited.
Chapter 1: Getting Started

Microsoft® Excel sits on top of Analyst as a means of displaying data held in D-Cubes. What you see in Excel is a file that can be treated like any other .xls file. The only difference is that when you want to refresh or recalculate the report using the underlying data and formulas, you need a link to Analyst. This can be a version of Analyst that runs on a stand-alone computer or a version that resides on the network server. It does not matter which version as long as you can link to the source data.

Chapter Summary

The chapters in this tutorial are designed to give you real-world examples of using Analyst for Excel. Beginning with a blank Excel spreadsheet, you open a normal view from data held in sample files. Then, using dynamic selections, you build complex reports containing several tables. You also create pivot tables that allow you to slice and dice the data using different combinations of rows, columns, and pages. You create hierarchical reports that can be expanded to view the details behind each subtotal. Finally you update existing reports, define a view, and use Options to make changes to the Excel view.

All data is stored in objects called D-Cubes (data cubes). A D-Cube is similar to a multi page spreadsheet. You access the D-Cubes in Analyst and use them to build your reports.

Before Starting the Tutorial

Check to see if you have the tutorialgo library installed.

Steps

1. In Analyst, from the File menu, click Administration, Maintain Libraries and Users. The tutorialgo library should be listed.

2. If it is not listed, you must add it. In the Administration dialog box, click the Libraries tab and then click Add.

3. In the Add New Library dialog box, type or select the library information as shown in the table below, and then click OK.

<table>
<thead>
<tr>
<th>Text box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library no</td>
<td>Leave this field blank to have the system assign a library number for you.</td>
</tr>
<tr>
<td>Name</td>
<td>tutorialgo</td>
</tr>
<tr>
<td>Description</td>
<td>Analyst Test Model</td>
</tr>
</tbody>
</table>
4. Open Analyst and check that you can open the sample data. The sample data consists of three D-Cubes (Profit and Loss, Sales, and Americas Overheads) and two D-Links (ProfitAndLoss>AmericasOverheads, and ProfitAndLoss<ProfitAndLossData).

5. Exit Analyst and start Excel.
   You now are ready to begin the tutorial.
Chapter 2: New View and Manipulating Report Data

In this section, you create a new normal view in an Excel spreadsheet using the data and formulas held in IBM Cognos Planning - Analyst. You produce a report using the standard facilities in Excel. You also create a new view using detailed selections. You then use the normal view as a means of entering and manipulating data in Analyst, using Excel as a front end. Finally, you save the Excel report.

Using the data from the Profit and Loss file, you will perform the following tasks:

- Create a view of the data
- Select the row, column, and page labels to display in the report
- Choose Detailed selection
- Choose auto-format option
- Change data and recalculate the data based on formulas held in Analyst
- Reset the data to its saved version
- Save the report

Logging on to Analyst

To start, you must first log on to Analyst.

Steps
1. Open Excel.
2. From the Analyst menu, click Log On.
3. Click OK.

Creating a New View

You now create a simple report based on the data contained in a D-Cube named Profit and Loss.

Steps
1. In a new Excel worksheet, click cell A1.
2. From the Analyst menu, click New View.
3. In the Analyst New View 1 of 5 dialog box, select tutorialgo from the Library list, select Profit and Loss from the D-Cubes list, and then click Next.
Tip: If you wanted to quickly open a view, you could click Finish. This would create a view in Excel showing all D-List items with your first D-List as rows, the last D-List as columns, and all other D-Lists as pages.

For now, however, you will be selecting specific rows and columns.

4. In the Analyst New View 2 of 5 dialog box in the Pages list, click 2 Divisions and click the down arrow to move it to the Rows list.
   - The Pages list is now empty.
   - The Rows list contains 2 Divisions and 1 Profit and Loss.
   - The Columns list contains 4 Months - Fiscal.

5. Click Next.

6. In the Analyst New View 3 of 5 dialog box under Selection type, click Detailed selection. The Analyst New View 3 of 5 dialog box allows you to make dynamic selections and select which rows, columns, and pages you want to show and hide. The list on the right shows the items that are included; the list on the left shows the items that are excluded. The default mode is to include all items. An empty selection means that all items, present and future, are available in Excel.

The Expand button selects the components of a formula or subtotal that could influence, directly or indirectly, the formula result. It applies to both lists. You can click Expand to expand several formulas at once. This is a useful way to check that a set of subtotals has no missing items.

The Sort button allows you to sort selected items in D-List order. The sorting option applies to the selected items in the Items included list (Items in the Items excluded list are always shown in D-List order). The Sort button does not sort according to data values or other criteria. To sort using data values or other criteria, use the Sort and Filter commands on the Data menu.

Note: If no items are selected and you click the left or right arrow button, all items are moved.

7. In the Row D-List drop-down box, select 2 Divisions.

8. In the Items included list, click Total Company and click the left arrow button to move it to the Items excluded list.


10. In the Items included list, click Full Year.

11. Click and hold the up arrow button until Full Year displays as the first item in the list. This makes Full Year the first column.

12. Click Next.

13. In the Analyst New View 4 of 5 dialog box are view options.

   Keep all defaults, but ensure that Allow Break-back on recalculate is selected. This allows you to perform a two-way calculation, similar to the Solve facility in Excel. Later in the chapter, you will use this facility to enter numbers into a total and let the program automatically recalculate the details that add up into the total.
You can change these view settings individually. This will be covered in later chapters.

14. Click Next.

15. In the Analyst New View 5 of 5 dialog box, you can choose autoformat options. Keep the default settings and click Finish.

Analyst for Excel uses the standard Excel auto-formats. The following options are available: Number, Font, Alignment, Border, Patterns, and Width/Height. You must choose at least one format option. You can apply more of these options at a later date, but you cannot clear these options retrospectively.

You may also choose from 16 standard Excel table formats to display your data.

If you are using autoformats, it is advisable to turn the foreground and background colors off to prevent these from overwriting the autoformat colors. From the Analyst menu, click View, Options. For more information about viewing options, see "Using Analyst Options" (p. 49).

To preserve any custom formatting you may have applied, autoformats are not re-applied automatically on refresh. If you insert new items immediately below formatted subtotals or column headings, Excel will take the formatting from the previous row. You may re-apply autoformatting by choosing View from the Analyst menu and selecting Autoformat.

16. The selected view appears in Excel with the numbers highlighted to allow you to format the data. A message appears stating where the new view is located on the worksheet. Click OK.

You are viewing an Excel spreadsheet with the data transferred in from the Profit and Loss D-Cube. The data and formulas are stored in Analyst. Excel sits on top of Analyst and is used as a means of displaying the data.

The row labels are copies of two D-Lists. The Profit and Loss D-List contains a list of profit and loss items (Units Sold, Unit Price, Sales, etc.). The 2 Divisions D-List contains a list of divisions (Americas, Northern Europe, Central Europe, etc.). The column labels contain items from the 4 Months - Fiscal D-List (Apr, May, Jun, etc.).

Note: The key to the view is stored in a note in the red cell at the top left of the sheet. The note contains parameters defining how Excel should display the data held in Analyst. To view the note, place the cursor over the cell.

### Recalculating, Saving, and Resetting

You can enter data directly into a spreadsheet and use the formulas held in Analyst to calculate the results. You can also use the standard Analyst commands, such as add10, sub5, inc10, decr10, gr10l, gr10c, hold, lock, protect, and the copy commands (including the break command). For more information on Analyst copy commands, see the Analyst and Manager Online Help.

The colon (:) on its own (without a copy command) acts as a null operator, meaning refresh this cell. This can be useful if you have made some mistakes, but want to recalculate part of a table. You can type the colon in the incorrect cells and recalculate the table to refresh those cells with the saved data.
**Tip:** There is an alternative to using the Analyst copy commands. Select the ranges you want to target, type the data you want to copy, and press Ctrl+Enter.

**Steps**

1. To see the effect of increasing the Overheads for the Americas division by 10% from May onward, place the cursor in the **Americas > Overheads > May** cell.

2. Type inc10> and press Enter.

3. From the **Analyst** menu, click **Recalculate** and click **Selected View**.

4. Reduce the annual overheads figure (because it is now too high) back to its original value. In the **Americas > Overheads > Full Year** cell, type 3.7M and press Enter.

5. From the **Analyst** menu, point to **Recalculate** and click **Selected View**.

   Although the Americas > Overheads > Full Year total is colored black to show that it has not changed, the months Apr to Mar are colored purple to show that these numbers have changed. In effect, you have changed the timing of the budget expenses over the months while keeping the annual total the same.

   Notice that you have typed a total for the Full Year and split this pro rata across the months. This uses the breakback function from Analyst as a means of setting a target.

6. To reset the data back to the saved version, from the **Analyst** menu, click **Reset D-Cube**.

   A message appears asking if you are sure you want to reset the D-Cube and refresh all views of it.

7. Click **Yes**.

   All views of the D-Cube are reset back to the saved version.
Saving the Excel Report

Save the Excel report by using the following steps:

**Steps**

1. On the **File** menu, click **Save**.

2. Select the tutorialgo sample from the **Save in** text box.
   
   **Tip:** Generally, the tutorialgo sample is found under Program Files\Cognos\c8\samples\<language>\Planning.

3. In the **File name** text box, type Tutorial.xls and click **Save**.

4. Close the view.

   **Note:** Clicking **Save** on the **File** menu saves only the Excel spreadsheet, not the data. To save the data in Analyst, from the **Analyst** menu, click **Save D-Cube**. If no D-Cubes are open for write access, a message will appear asking you to recalculate your views. It is important to recalculate before saving the D-Cubes so that the Excel view and the underlying D-Cube always have the same numbers. You might also need to click **Save** repeatedly if your report has views from several D-Cubes.
You have now created a new normal view in a Microsoft Excel spreadsheet using the data and formulas held in IBM Cognos Planning - Analyst. You produced a report using the standard facilities in Excel. You also created a new view using the dynamic selection Detailed selection.

In this section, you will use the Sales D-Cube and 2 Products D-List.

When creating a New View, you can choose specific selection types to include in your view. These include Detailed selection (which you used in Chapter 2), Entire D-List from within Detailed selection, Saved selection and Entire Cube.

Detailed selection: Allows you to choose specific D-List items to include or exclude within the pages of your D-Cube. The items you include will appear in your view. From within Detailed selection, instead of choosing specific items from a page, select the Entire D-List check box to include all items in the D-List. If you insert, delete, re-order, or rename an item in Analyst, it appears in the selection automatically.

Saved selection: Allows saved selections to come through to the Analyst for Excel.

This option is only available if you have named saved selections held in Analyst.

Entire Cube: Entire Cube means all items, present and future from all D-Lists in the D-Cube. Items may be inserted, deleted, re-ordered, or renamed at a later date. On refresh, any new items that were added to the underlying D-List are inserted in the correct place automatically. All deleted items are deleted automatically, and all renamed items are deleted and brought back in with the new name.

**Detailed Selection using Entire Cube and Saved Selection**

We will start by choosing a specific selection using an entire cube.

**Steps**

1. In a new Excel worksheet, from the Analyst menu, click New View.

2. In the Analyst New View 1 of 5 dialog box, select tutorialgo from the Library list, select Sales from the D-Cubes list, and then click Next.

3. In the Analyst New View 2 of 5 dialog box page selections are as follows.
   - Move 2 Cities to the Pages list by clicking 2 Cities and clicking the appropriate arrow.
   - Move 2 Products to the Rows list.
   - Move 4 Months - Calendar to the columns list.

4. Click Next.

5. In the Analyst New View 3 of 5 dialog box under Selection type, select Entire Cube.
The Analyst New View 3 of 5 dialog box allows you to make dynamic selections and select which rows, columns, and pages you want to show and hide. The list on the right shows the items that are included; the list on the left shows the items that are excluded. By clicking Entire Cube, all items are included. Entire D-List is similar to Entire Cube except that you can choose Entire D-List on some dimensions while choosing a detailed selection of specific items on other dimensions.

6. Click Next.

7. In the Analyst New View 4 of 5 dialog box, keep the default settings and click Next.

8. In the Analyst New View 5 of 5 dialog box, select the Classic 1 table format and then click Finish.

9. The selected view appears in Excel with the numbers highlighted to allow you to format the data. A message appears stating where the new view is located on the worksheet. Click OK.

10. Save the view as Tutorial2.xls.

Setting up a Saved Selection in Analyst

We will now set up a saved selection in Analyst and then use it to create a new view in Excel.

Steps
1. In Excel, if you are logged on already to Analyst, from the Analyst menu, click Log Off.

2. Start Analyst.

3. From the tutorialgo Library, open the Sales D-Cube and do the following.
   - From the File menu, click Open, D-Cube.
   - In the Select D-Cube screen, select tutorialgo and Sales, and then click OK.
   - Select Full mode and then click OK again.

All the D-List items are shown in the view.

18 Analyst for Microsoft®Excel
4. From the D-Cube menu, click Selections, Reselect.
   - The Reselect Tutorial.Sales screen appears. Click and drag to highlight Watches through Personal Accessories.
   - Click Move>> to move them to the Items included area.
   - Click OK. The D-Cube view changes to display Watches, Eyewear, Knives, Binoculars, Navigation, and Personal Accessories within the Products dimension.

5. Now, from the D-Cube menu, click Selections, Save current. From the Save Selection As dialog box, under Selection Name, type Personal Accessories and click OK.


7. In Excel, from the Analyst menu, click Log On. We will now create a new view below the first view using the saved selection Personal Accessories.

8. Click cell A38.

9. From the Analyst menu, select New View.

10. In the Analyst New View 1 of 5 dialog box, select tutorialgo from the Library list, select Sales from the D-Cubes list, and then click Next.

11. In the Analyst New View 2 of 5 dialog box, select 2 Cities for Pages, 2 Products for Rows, and 4 Months - Calendar for Columns and then click Next.

12. In the Analyst New View 3 of 5 dialog box under Selection type, select Saved selection, then choose Personal Accessories from the Saved selection drop-down list, select Products from the Detailed selection drop-down menu, and then click Next.

   Note: If you do not have any saved selections in the Sales D-Cube, this option will be grayed out.

13. In the Analyst New View 4 of 5 dialog box, click Next.

14. In the Analyst New View 5 of 5 dialog box, again select Classic 1 table format and then click Finish.

15. The selected view appears in Excel below the original Sales view, with the numbers highlighted to allow you to format the data. A message appears stating where the new view is located on the worksheet. Click OK.
The row labels are copies of the saved selection Personal Accessories.

The text labels tell Analyst where to display the data. For example, cell B42 has the label Watches and Jan. These labels are only text, and there is nothing unusual about them. Excel looks in the appropriate D-Lists to find an exact character match for the labels. When an exact match is found, Excel pulls the data from these coordinates in the D-Cube into cell B42 of the spreadsheet.

**Delete, Rename, Add and Sort Items**

You will now see how easy it is to make changes to the Analyst D-List and see how the changes are reflected in the Excel view. We will start by making some changes to the 2 Products D-List items, including changing and adding D-List items. We will then add the new item we created to our saved selection Personal Accessories. When we refresh views in Excel, all the changes we made to the D-List will be reflected in the Excel view.

**Steps**

1. In Excel, if you are logged on to Analyst, from the Analyst menu, click Log Off.
2. Start Analyst.
3. Open the 2 Products D-List and do the following.
   - Select Open from the File menu, then click D-List.
   - From the tutorialgo library, click 2 Products, and then click OK.
4. Insert Clothing just above Personal Accessories. Click Personal Accessories, then select Add Items from the D-List menu and click Input.
5. In the Input new Items dialog box, type Clothing and click OK.
6. In the Position new items dialog box, move Clothing to the Items included list and then, using the arrows, position it above Personal Accessories. Click OK.
7. Rename Watches to Sport Watches. Highlight Watches, then click once more, rename it, and then press Enter.
8. To delete Eyewear, do the following:
   - Select **Delete Items** from the D-List menu.
   - In the Select which items to delete dialog box, select **Eyewear** and click **Move>>** to bring it over to the Items included list, and then click **OK**.
   - Click **Yes** at the verification message. The item is deleted from the D-List.

9. Save the **2 Products** D-List.

10. Open the **Sales** D-Cube and do the following.
    - From the **File** menu, click **Open**, **D-Cube**.
    - Select **Sales** and click **OK**.
    - In the Mode box, select **Edit Selection** and then click **OK**.

11. In the Select dialog box, click **Load** to load the **Personal Accessories** saved selection.

12. In the Choose saved selection dialog box, select **Personal Accessories** and then click **OK**.

13. In the Select dialog box again, you will now enter the new item Clothing, into the correct place within the Personal Accessories list. In the Items available list, highlight **Clothing** and then click **Move>>** to bring the item to the Items included list. Clothing appears at the bottom of the list.

14. You now need to move Clothing up one position to be above Personal Accessories. Highlight **Clothing** and click the up arrow (up arrow button without a line over it) to move it up one position.

15. Re-save the selection. From within the Select dialog box, under Saved selections, click **Save**. In the Open or save a selection dialog box, select **Save selection** and then click **OK**. The message **View Saved** will appear. Click **OK**. Then click **OK** again on the Select dialog box.

16. You have now made changes to the **2 Products** D-List and added the changes to the saved selection Personal Accessories. Close the **Sales** D-Cube and **2 Products** D-List and close Analyst.

17. In Excel, from the **Analyst** menu, click **Log On**. If it is not up already, bring the Tutorial2.xls Excel view back up. You will now refresh all the views to see the changes you made to the **2 Products** D-List and **Sales** D-Cube reflected in your Excel view.

18. Select **Refresh** from the **Analyst** menu, and then click **All Views**.
    Notice that Watches is now Sport Watches; Eyewear is deleted; and Clothing is added above Personal Accessories. All the changes you made in Analyst are automatically brought over to the Excel view.

Chapter 3: Dynamic Selections
Chapter 4: Multiple Views on a Single Page

In this section, you create a more complex report containing two views displayed from two separate D-Cubes named Americas Overheads and Profit and Loss. You set up the report so that when you change the page to a different month, all the views scroll in synchrony. Finally, you create buttons to refresh the report by updating it from the underlying data held in IBM Cognos Planning - Analyst.

Displaying Multiple Views on A Single Page

Display two views from separate D-Cubes.

Steps

1. Open a new Excel worksheet. If you are not logged on already, from the Analyst menu, click Log On.

2. Move the cursor to cell A1 and from the Analyst menu, click New View.

3. In the Analyst New View 1 of 5 dialog box, select the tutorialgo library, select the Profit and Loss D-Cube, and then click Next.

4. In the Analyst New View 2 of 5 dialog box, select 4 Months - Fiscal as pages, 1 Profit and Loss as rows, 2 Divisions as columns, and then click Finish.

   Note: If you do not specify a selection, Analyst for Excel displays every item in D-List order.

5. A message appears stating where the new view is located on the worksheet. Click OK.

   The selected view appears in Excel with the numbers highlighted to allow you to format the data.

6. On a single worksheet, you see a view that contains several pages. Currently the Apr page of the Profit and Loss D-Cube is displayed. Click the drop-down list to change the page to May.

   Analyst for Excel transfers data from the May page of the Analyst D-Cube into the current Excel worksheet.

7. Now create a new view from the Americas Overheads D-Cube. With the cursor in cell A15, from the Analyst menu, click New View.
8. In the Analyst New View 1 of 5 dialog box, select the tutorialgo library, select the Americas Overheads D-Cube, and then click Next.

9. In the Analyst New View 2 of 5 dialog box, select 4 Months - Fiscal as pages and 1 Overheads as rows and click Finish.

10. A message appears stating where the new view is located on the worksheet. Click OK.

The selected view appears in Excel with the numbers highlighted to allow you to format the data.

```
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Profit and Loss</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>May</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Apr</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Apr</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Americas</td>
<td>Northern Europe</td>
<td>Central Europe</td>
<td>Southern Europe</td>
<td>Asia Pacific</td>
<td>Total Company</td>
</tr>
<tr>
<td>5</td>
<td>Units Sold</td>
<td>13,412</td>
<td>11,394</td>
<td>19,180</td>
<td>8,404</td>
<td>8,099</td>
</tr>
<tr>
<td>6</td>
<td>Unit Price</td>
<td>156.62</td>
<td>139.72</td>
<td>167.36</td>
<td>121.69</td>
<td>191.00</td>
</tr>
<tr>
<td>7</td>
<td>Sales</td>
<td>2,103,270</td>
<td>1,630,286</td>
<td>3,206,426</td>
<td>1,022,603</td>
<td>1,150,085</td>
</tr>
<tr>
<td>8</td>
<td>Margin %</td>
<td>31.12</td>
<td>28.00</td>
<td>30.06</td>
<td>30.33</td>
<td>40.70</td>
</tr>
<tr>
<td>9</td>
<td>Overheads</td>
<td>564,536</td>
<td>499,333</td>
<td>591,748</td>
<td>310,180</td>
<td>469,405</td>
</tr>
<tr>
<td>10</td>
<td>Total</td>
<td>300,423</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>Profit</td>
<td>364,114</td>
<td>499,333</td>
<td>591,748</td>
<td>310,180</td>
<td>469,405</td>
</tr>
<tr>
<td>12</td>
<td>Profit %</td>
<td>16.64</td>
<td>30.20</td>
<td>30.93</td>
<td>30.33</td>
<td>40.70</td>
</tr>
</tbody>
</table>
```

Simultaneous Page Scrolling

You now have two normal views from two separate D-Cubes open on the screen. Both D-Cubes share the 4 Months - Fiscal D-List, and both views scroll through the pages independently. To link the two views so that they both change page at the same time, you must set up a formula that refers to the text underneath the drop-down menu.

**Steps**

1. Remove the second drop-down menu. Press Ctrl and click the second drop-down menu (cell A16 in the example, which contains Apr). Press Delete.

   The drop-down menu disappears and displays the text Apr.

   Now change the drop-down menu of the top report to Jun.

2. To make cell A16 display the same month as the report above it, move the cursor to cell A16 and type the formula =A2 (the cell containing the text for the page labels in the upper view) and press Enter.
Jun appears in cell A16.

**Note:** The formula for shared pages must refer to the cell containing the page text instead of the cell containing the drop-down menu. Although these usually occupy the same cell, they do not have to. If you press Ctrl and click the drop-down menu, you can move it to any position on the spreadsheet.

The lower view refreshes as soon as you change the page in the upper view.

3. Change the Profit and Loss page to Jul. The Americas Overheads view also changes to Jul.

**Refreshing Views**

Because the Excel spreadsheet contains only a snapshot of the data held in Analyst, from time to time you must refresh your report to keep it up to date. One way of doing this is to assign the Refresh action to a text box so that the view is refreshed every time you click the text box.

**Steps**

1. Select the cell where you want to position the text box containing the Refresh action. In this example, select cell C2.

2. From the Analyst menu, click Assign Action and click Refresh.

There are several ways to refresh a report. To refresh the report from the underlying numbers held in Analyst, from the Analyst menu, point to Refresh and click All Views. This refreshes all views and graphs in the entire workbook.

To quickly refresh the current view only, from the Analyst menu, point to Refresh and click Selected View. If you have several views, this option is quicker, but other views might need refreshing later on. To refresh the current view and any other view in the workbook that uses the same D-Cube, point to Refresh on the Analyst menu and then click Views of D-Cube.

To automatically refresh a view when you open the report, from the Analyst menu, point to View and click Options. In the Analyst View Options dialog box, select the Refresh view on loading check box. The next time you open the Excel file, the old numbers are overwritten by
the latest up-to-date figures held in Analyst. This refreshes the view and any other view in the workbook that uses the same D-Cube.
As an alternative to using the menus or refreshing every time you open the Excel file, you can insert buttons, text objects, or bitmaps and assign the refresh action to the object. From the Analyst menu, point to Assign Action and click Refresh.

3. With the Analyst Assign Action dialog box active, click the Profit and Loss red D-Cube cells in the Excel view (cells $A$1 in the example), and then click OK.

4. If you cannot remember which view the text box refers to, press Ctrl and click the text box. Then click and drag the middle sizing handle at the bottom of the text box until the name of the view being refreshed appears.
   Click and drag it back to the original size when you are finished.

### Running a D-Link

You can add D-Links to your report to transfer information between the report views. In this section, you change a number in the lower report view, and then run a predefined D-Link called ProfitAndLoss>AmericasOverheads that transfers the Total Overheads figure from the lower report view into the Overheads item in the upper report view. This transfers data from the Americas Overheads D-Cube to the Profit and Loss D-Cube.

**Note:** Although an Excel formula could transfer information between views in a simple situation such as this tutorial, in a real situation where there might be hundreds of overhead lines across regions and months as well as different versions, a D-Link would be easier to maintain.

**Steps**

1. Move to the lower report view and change the salaries for Jul to 275,000 and press Enter.

2. From the Analyst menu, point to Recalculate and click Selected View.

3. Run the D-Link. From the Analyst menu, point to Run and click D-Link.

4. In the Select a Dlink dialog box, select the tutorialgo library, click the ProfitAndLoss>Amer-icasOverheads D-Link, and then click OK.

5. After running the D-Link, click the Refresh text box to refresh the upper report view.
6. To reset the data to the original numbers, move the cursor to anywhere in the middle of the lower report view and from the Analyst menu, click Reset D-Cube.

7. A message appears asking if you are sure you want to reset the Americas Overheads D-Cube and refresh all views of it. Click Yes.

8. Run the D-Link again to update the Profit and Loss D-Cube. From the Analyst menu, point to Run and click D-Link.

9. In the Select a Dlink dialog box, select the tutorialgo library, select the ProfitAndLoss>Amer-icasOverheads D-Link, and then click OK.

10. Click the Refresh text box.

    The report now is ready. When you return to the report later, you can click the Refresh text box to transfer the latest data from the underlying Profit and Loss D-Cube held in Analyst.

    You now have completed the chapter.

11. Save the Excel file as Tutorial3.xls and close the file.

    You will use this file in a later chapter.
Chapter 4: Multiple Views on a Single Page
Chapter 5: Creating a Pivot View

In this section, you create a new view of the data called a pivot view. A pivot view provides you with an easy way to switch rows, columns, and pages to present data in different ways.

Create a pivot view with the Pivot Table action.

Steps
1. Open a new Excel worksheet. If you are not logged on already, log on to IBM Cognos Planning - Analyst.
2. From the Analyst menu, click New View.
3. In the Analyst New View 1 of 5 dialog box, select the tutorialgo library, select the Profit and Loss D-Cube, and then click Next.
4. In the Analyst New View 2 of 5 dialog box, select 4 Months - Fiscal as pages, 1 Profit and Loss as rows, 2 Divisions as columns, and then click Next.
5. In the Analyst New View 3 of 5 dialog box, select 2 Divisions from the Detailed selection drop-down list. In the Items included section, select Total Company and move it to the Items excluded list. This will keep Total Company figures out of the view. Click Next.
6. The Analyst New View 4 of 5 dialog box. In the View Style area, select Pivot Table and then click Finish.
7. A message appears stating where the new view is located on the worksheet. Click OK.
   The data that displays is initially labeled All to indicate that it is adding up all the pages and displaying the result.
8. To change pages, click the drop-down menu in the B1 cell and select Full Year.
9. Click OK.
10. Change the orientation to show 4 Months - Fiscal as columns, 2 Divisions as pages, and 1 Profit and Loss as rows. To swap pages and columns, drag the gray box labeled 4 Months - Fiscal onto the column labels and drag the 2 Divisions box onto the page labels. When you release the mouse button, the orientation of the pivot view changes.
11. Click the drop-down menu and select the **Northern Europe** division.

12. Click **OK**.

13. Show a different view by merging the row and column labels. Drag **4 Months - Fiscal** into the row label section. **1 Profit and Loss** should automatically move just to the right of it so that **1 Profit and Loss** items appear as the second row label.

14. If you wish to hide rows, select the rows and, on the **Format** menu, click **Row** and click **Hide**.

15. Save the Excel file as Tutorial4.xls and close the file.
Chapter 6: Hierarchical Views

In this section, you create a new view called a hierarchical view. Use a hierarchical view when you have totals, subtotals, and grand totals, and you want to expand and collapse branches of the hierarchical tree. The hierarchical view uses the standard Excel outline symbols to show or hide specific groups of detail.

You will also learn how to insert custom items into a spreadsheet. A custom item is a label entered in Excel that does not match an item in a D-List. You insert the custom item % of total and calculate the sales in each city as a percentage of the total sales for the company, using standard Excel formulas.

Creating a Hierarchical View

Create a hierarchical view using the Sales D-Cube from the tutorialgo library. The Sales D-Cube has three D-Lists: 2 Cities, 2 Products, and 4 Months - Fiscal. A simple hierarchical structure exists on both the 2 Cities and 2 Products dimensions. 2 Cities add up into countries, which in turn add up into a company total. Similarly, products add up into brands, which in turn add up into a product total.

Steps

1. Start with a new Excel worksheet and log on to IBM Cognos Planning - Analyst (if you are not logged on already).

2. From the Analyst menu, click New View.

3. In the Analyst New View 1 of 5 dialog box, select the tutorialgo library, select the Sales D-Cube, and then click Next.

4. In the Analyst New View 2 of 5 dialog box, select 4 Months - Calendar for pages, 2 Cities for rows, and 2 Products for columns, and then click Next.

5. Click Next until you reach the Analyst New View 4 of 5 dialog box. In the View Style area, select Hierarchical and then click Finish.

The selected view appears in Excel with the numbers highlighted to allow you to format the data.
6. You can expand or contract different branches of the hierarchy by clicking the plus (+) or minus (-) button. Click the plus button next to the France label to reveal the cities that make up the subtotal.

To contract the view to only the country level again, click the minus button next to the France label.

7. To expand the subtotals to reveal all items on each level of the hierarchy, in the top left corner, click the (1, 2, 3) buttons in turn.

This displays the company total at level 1, expands to the country totals at level 2, and then expands to the individual cities at level 3. You can apply the same expansion to the products by clicking the corresponding buttons at the top left of the report.

8. Display the level 3 subtotals for rows and the level 2 subtotals for the columns.

9. To remove the plus and minus buttons that expand and contract the hierarchy, on the Tools menu, click Options.

10. In the Options dialog box, click the View tab.

11. In the Window options area, clear the Outline Symbols check box and click OK.
Inserting Custom Items

You can insert custom items into a worksheet to perform your own calculations using Excel formulas. A custom item is any label that does not match a D-List item. Such items are not refreshed directly from Analyst, but can use Excel formulas to perform calculations based on cells in the view.

Steps

1. Insert a custom item labeled % of total into cell AC4 to calculate the sales for each city as a percentage of the Company total.

<table>
<thead>
<tr>
<th>K</th>
<th>Y</th>
<th>AA</th>
<th>AS</th>
<th>AC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Accessories</td>
<td>Outdoor Protection</td>
<td>Golf Equipment</td>
<td>Product Total</td>
<td>% of total</td>
</tr>
<tr>
<td>5,999.04</td>
<td>2,238.00</td>
<td>0.00</td>
<td>59,472.00</td>
<td></td>
</tr>
<tr>
<td>25,806.80</td>
<td>2,594.02</td>
<td>0.00</td>
<td>106,777.52</td>
<td></td>
</tr>
<tr>
<td>41,806.82</td>
<td>4,783.05</td>
<td>0.00</td>
<td>208,259.42</td>
<td></td>
</tr>
</tbody>
</table>

2. To calculate the percentage of total, in cell AC5, type the Excel formula =AB5/$AB$53 and press Enter.

3. Format the cell to display as a percentage. Click cell AC5 and do the following:
   - On the Format menu, click Cells.
   - In the Format Cells dialog box, click the Number tab.
   - In the Category list, click Percentage.
   - In the Decimal places text box, select 2 and click OK.

4. Copy the formula down the entire column by doing the following:
   - In the AC5 cell, click the Copy icon, or select Copy from the Edit menu.
   - Click cell AC6 and drag the cursor to cell AC53.
   - Click the Paste icon or select Paste from the Edit menu.

5. Optional. Apply one of the Excel standard formats to the report.
   - Click anywhere in the middle of the report.
   - Select View from the Analyst menu, then click Autoformat.
   - In the Analyst AutoFormat View dialog box, select Classic1 from the Table Formats list.

6. Click OK.

7. Change the page. Click the drop-down menu and select Feb.
When you change pages, you are not actually moving to a different worksheet. You are simply transferring a different set of data from Analyst. This means that custom Excel formulas that refer to cells on the current worksheet continue to calculate correctly no matter which page you are on. If you are going to update the report on a regular basis by inserting and deleting items from the underlying D-List, you must expand the range for the column headings to include the AC4 cell that contains the custom item to make sure that it is updated. Because % of total was inserted as the last column, it does not fall within the range of columns defined for the view. Unless a column is within the column range defined for the view, the program has no way of knowing that you want this column updated when you add and delete items.

If you insert custom items in the middle of the range, the range expands automatically. It is only when you insert a custom item as the first or last row or column that this extra step is needed.

8. On the Insert menu, point to Name and click Define.

9. In the Define Name dialog box, select the analyst_col_1 range. The Refers to text box should display =Sheet1!$B$4:$AB$4. Change it to display =Sheet1!$B$4:$AC$4.

   This changes the definition to encompass the full range.

   **Tip:** To quickly edit range name definitions, in the Refers to text box, press F2, and then edit the range definition manually. Or, in the Refers to text box, drag the required range to the spreadsheet using the mouse.

10. Click OK.

    You now have created a hierarchical view, hidden the outline symbols, and inserted a custom item.

11. Save the Excel file as Tutorial5.xls and close the file.

    You will use this file in the next chapter.
Chapter 7: Updating an Existing Report

In this section, you make changes to the Sales D-Cube. Instead of starting from scratch with a new report, you adapt this existing report to reflect the changes to the data that occur in the underlying D-Cubes and D-Lists.

Earlier in the tutorial, you saw how the views adapted automatically to renaming, deleting, inserting, and re-ordering row, column, and page labels. However, if you choose a detailed selection, you will need to adapt these using Reselect View from the IBM Cognos Planning - Analyst menu. This chapter shows how to update an existing view the long way, in cases where you have decided not to use the dynamic selections.

You can also update your report to reflect the following structural changes:

- Changing D-Cubes
- Renaming D-Cubes, D-Lists, libraries, D-Links, and macros
- Renaming D-List items in IBM Cognos Planning - Analyst
- Renaming labels in Excel
- Inserting D-List items
- Deleting D-List items
- Reordering D-List items
- Adding or deleting D-Cube dimensions

Renaming the D-Cube

Start by renaming the D-Cube.

Steps
1. If Analyst is not running, start Analyst. You have to work in Analyst to change the D-Cube.
2. In Analyst, from the File menu, click Library, D-Cubes.
3. Select tutorialgo from the drop-down list of libraries.
4. In the D-Cube Library Functions dialog box, double-click the Sales D-Cube. The Sales D-Cube item moves to the Objects Selected window.
5. Click the Rename button.
6. In the Move/Rename dialog box in the New Name text box, type New Sales and click OK.
7. Close the D-Cube Library Functions dialog box.
Changing and Deleting D-List Items

Name changes and deletions are easily done in the Item name list.

Steps
1. In Analyst on the File menu, click Open, D-List.
2. In the Select D-List dialog box, select the 2 Cities D-List from the tutorialgo library and click OK.
3. From the [D-List] tutorialgo.2 Cities D-List, in the Item name list, double-click Lyons item name and change it to its correct spelling of Lyon and then press Enter.
4. We will now delete Paris. In the Item name list, click the 1 next to the Paris item name to highlight the row.
5. Press Delete. A message appears stating that you are about to delete an item and asks if you want to proceed. Click Yes.

Inserting Items into an Existing Subtotal

A common requirement is to insert new items into a subtotal.

Steps
2. From the Input new Items dialog box, in the Subtotals list click France.
3. In the Enter item names window, type a new item called Bordeaux and click OK.
4. From the Position new items dialog box in the Items Available list, click Bordeaux and then click Move. Analyst moves Bordeaux to the end of the Items Included list.
5. Use the arrow buttons to the right of the Items Included list to position Bordeaux just above the France subtotal and then click OK.
6. Insert another new item, but this time do not add it to any existing subtotal. With [D-List] tutorialgo.2 Cities still open, from the D-List menu, click Add Items, Input.
7. From the Input new Items dialog box in the Enter item names window, type the new item called 3rd Party Sales, and then click OK.
8. From the Position new items dialog box in the Items Available list, click 3rd Party Sales, Move. Analyst moves the 3rd Party Sales item to the end of the Items Included list, beneath the Company Total item.
9. Click OK.

**Reordering D-Lists**

You can manually move items above or below others in a list.

**Steps**


2. In the Reorder items dialog box, move the UK cities and UK subtotal by doing the following:
   - In the Items Included list, click the London item, press SHIFT, and then click the United Kingdom item to highlight the group.
   - Click the up arrow button repeatedly until the selected items are positioned just above Boston, the first of the United States cities.
   - Click OK.

3. Save and close the tutorialgo.2 Cities D-List.


**Refreshing a View**

Now that you have made some extensive modifications to the underlying D-Cube in Analyst, you must update the report in Excel.

**Steps**

1. In Excel, open the Tutorial5.xls file.

2. From the Analyst menu, click Refresh, Selected View.
   
   A message appears stating that the program cannot find the tutorialgo.Sales D-Cube. Before you can refresh, you must change the text in the view definition to refer to the new D-Cube name.

3. Click OK.

4. Leave the file open.
Replacing the D-Cube Name

You now change the text in the view definition so that it refers to the new D-Cube name, New Sales.

Steps
1. In the Tutorial5.xls file, from the Analyst menu, click Auditing, Replace object names in all definitions.
   If you have several views of a D-Cube, the text in the view definitions (and any other objects) are replaced globally.
2. In the Analyst Replace Names 1 of 3 dialog box, select the D-Cube option and click Next.
   The Analyst Replace Names 2 of 3 dialog box appears with the Sales D-Cube listed in the Original Name list and the list of all available D-Cubes from all libraries in the Replacement Name list.
3. In the Original Name list, select Sales, and in the Replacement Name list, select New Sales and click Next.
   If you have several views, you can replace the D-Cube name in one or all of the views. Here, you have only one view named Sheet1!analyst_view_1.
4. In the Analyst Replace Names 3 of 3 dialog box in the Replace text in these objects list, select Sheet1!analyst_view_1 and then click Finish.
5. A message appears stating that you should ensure that the altered objects work correctly before saving. Click OK.
6. Leave the file open.

Updating the Row, Column, and Page Labels

You can now update the row, column, and page labels by refreshing the selected view.

Steps
1. From the Analyst menu, click Refresh, Selected View.
2. A message appears stating that you have incomplete totals and asking if you would like to refresh anyway. Click Yes.
   Items within the ranges defined for the rows and columns that do not match an item in the D-List appear in red. If you have not changed the default view options, these should already be present. To use this color coding, from the Analyst menu, click View, Options. In the Analyst View Options dialog box, select the Auto Color - Foreground Data Cells check box and click OK.
3. Leave the file open.
Renaming and Deleting D-List Items

When you rename a D-List item, add a custom item, or delete a D-List item from your D-List within Analyst, you must update the Excel report to use the new names or the underlying data cannot be refreshed successfully. If you know the exact spelling of the renamed row or column labels, you can type the labels directly in the spreadsheet. If the new names are an exact character match to current D-List items, they are refreshed successfully. The matching process is case sensitive.

Steps to Rename a D-List Item
1. From the Analyst menu, click Auditing, Check View for renamed D-List items.
2. In the Analyst Update D-List Items dialog box, match the existing item with the item you renamed in the 2 Cities D-List, in this case Lyons and Lyon.

   The Convert to custom in rows/columns list (in the upper left window) shows the invalid items in your report. The Unmatched D-Lists list (in the upper right window) shows all unmatched items that are available in the current D-List but that have not yet been selected.
   
   - Click Lyons.
   - In the Unmatched D-Lists list, click Lyon.
   - Click Match.

   The items move to the Matched Items windows. Keep the Analyst Reselect D-List Items dialog box open.

Steps to Delete a D-List Item
1. In the Analyst Update D-List Items dialog box, delete the invalid item that you deleted from the 2 Cities D-List earlier in this chapter, in this case Paris.
2. In the Convert to custom in rows/columns list, click Paris, and then click Delete. The item moves to the Deleted items window.
3. Click OK. Keep the Analyst Reselect D-List Items dialog box open. If it isn’t open, a message will ask you to refresh. Click OK.

Inserting New D-List Items

You will now include Bordeaux in the view.

Steps
1. In the Analyst Reselect D-List Items dialog box, click Detailed selection, then in the Page D-List 1 of 1 drop-down box, select the 2 Cities D-List.

   The Items excluded list displays the items that are available for selection. The Items included list displays the items currently included in the view.

   The next step is to insert the new items. In this chapter, you want only those new items that belong to totals and subtotals in the current selection. In this case, you want to include Bordeaux
because you added it to the existing subtotal in the 2 Cities D-List. You want to exclude new items that are not part of this hierarchy.

2. In the Items excluded list, click Bordeaux.

3. In the Items included list, click Company Total and click Expand.

4. To include Bordeaux in the selection, click the right arrow button.

    Analyst inserts Bordeaux at the bottom of the Items included list. Bordeaux will be sorted in the next section.

    The Items included list now should contain a full list of all the items you want to include in your selection.

    Keep the Analyst Reselect D-List items window open.

### Sorting D-List Items

You now are ready to sort the items. You can sort the items manually using the up and down arrow buttons, or you can sort the items in the new D-List order.

**Steps**

1. To sort the items in the new D-List order, in the Items included list, highlight all the items and click Sort.

    Bordeaux automatically moves into its correct position just above the France subtotal.

2. Click OK.

3. To ensure that the numbers are up to date, from the Analyst menu, click Refresh, Selected View.

4. Save and close the file.

### Batch Printing Data

You now use the Batch Printing option in Analyst for Excel.

The sample data comes from the New Sales D-Cube with the dimensions Products by 2 City by 4 Months - Calendar. You use the batch printing facilities to print the same report for a selection of pages.

### Creating a New View

You start by creating a new view.

**Steps**

1. In Excel, open a new worksheet.

2. From the Analyst menu, click New View.
3. In the Analyst New View 1 of 5 dialog box, select the New Sales D-Cube from the tutorialgo library and click Next.

4. In the Analyst New View 2 of 5 dialog box, select 2 Cities as pages, 2 Products as rows, 4 Months - Calendar as columns, and then click Next.

5. In the Analyst New View 3 of 5 dialog box, click Detailed selection, then in the Detailed selection drop-down box, select the 2 Products D-List.

6. Exclude the Camping Equipment, Mountaineering Equipment, Personal Accessories, Outdoor Protection, Golf Equipment and Product Total items by clicking the item in the Items included list and then clicking the left arrow button. This hides the rows so they are not included when the Add-in sorts the rows.

7. In the Detailed selection drop-down box, select the 4 Months - Calendar D-List.

8. In the Items included list, reorder the items so Year is the first item and then click Finish.

9. A message appears stating that the new D-Cube is located at range Sheet!analyst_view_1. Click OK.

10. Keep the view open.

**Batch Printing Selected Data**

Batch printing takes the active view and copies each page (based on a selection of items from the drop-down menu) to a different sheet, ready for printing or editing. It takes a few seconds to create each sheet.

You should refresh or recalculate the view before you create the new sheets. Otherwise, you are prompted to refresh each sheet in turn, which can take time. However, it is quicker to apply formatting and subtotals after you have created the new sheets. To format several similar sheets at once, press Ctrl and click the tabs at the bottom of each report to group them, and then format the top sheet. The formatting applied to the first sheet applies to all the selected sheets.

If you apply the formatting first and then create the sheets, the Add-in takes longer to create the sheets, but it is easier to preserve the formatting if the D-List items change.

When you later open the report, you should update the original view with the modified D-List items. From the Analyst menu, click Reselect View. From the Analyst menu, click Batch Printing and then click Create Sheets. When you create the new sheets, the Add-in preserves any formatting applied to the original sheet. A new set of sheets is created each time.

**Steps**

1. In the open view, from the Analyst menu, select Batch Printing and then click Create Sheets.

2. In the Analyst Batch Print 1 of 2 dialog box, click Detailed selection, make sure 2 Cities is selected from the Detailed selection drop-down box.
   - Click Bordeaux, hold the Shift button and click 3rd Party Sales to highlight everything between them.
Click the left arrow button to move the highlighted selections to the Items excluded list.

Click Next.

3. In the Analyst Batch Print 2 of 2 dialog box, the item Lyon is placed in the Pages to be created list. Click Finish.

If you have more than one page, each page is placed on a separate sheet. After sheets are created, they remain grouped, as indicated by the white tabs at the bottom of each sheet.

4. Include Sheet1 in the group by pressing Ctrl and clicking the Sheet1 tab at the bottom of the report. The Sheet1 tab turns white to indicate that it is now part of the group. When you group sheets this way, any formatting you apply to the top sheet is automatically copied to the other sheets.

5. To add another sheet without creating a whole new view, click the Sheet1 tab at the bottom of the view.

   - Click Batch Printing from the Analyst menu and again select Create Sheets.

   - We want to add Bordeaux, so click France and holding the Shift key, click 3rd Party Sales to highlight everything between them.

   - Click the left arrow button to move the highlighted selections to the Items excluded list.

   - Click Next.

6. Click Select existing pages in the Analyst Batch Print 2 of 2 dialog box. The purpose of the Select existing pages button is to highlight all existing pages of views of that D-Cube. This avoids recreating sheets that were previously inserted in a batch print.

   - Click the left arrow button to move the highlighted Lyon page to the Pages to be omitted column. This leaves Bordeaux alone under Pages to be created.

   - Click Finish.

The new Bordeaux sheet is added to the view. Reorder the sheets to place Bordeaux after Lyon by clicking and dragging the Bordeaux tab.

7. Make sure that all the sheets remain selected.

   - In Sheet 1, Cell A26, type Total Products.

   - In cell B26, type the following formula =SUM(B5:B25) and press Enter.

   This formula adds up all rows in the range, including any hidden rows. Make sure you copy the formula across all columns. Widen the column if needed to view the full number range.

8. Keep the view open.
Printing the Report

Before you print the sheets or perform a print preview, you should define the page setup. This allows you to set the fit-to-page layout and orientation across multiple pages at once.

Steps
1. Press Ctrl and click the tabs at the bottom of each sheet to select those that you want to print.
2. From the File menu, click Page Setup.
3. In the Page Setup dialog box, set the desired page setup options and click OK.
4. From the File menu, click Print.
5. In the Print dialog box in the Print what area, click the Active Sheet(s) option and then click OK.
   You now have completed the chapter.
7. Close the file.
Chapter 8: Defining a View

In this section, you convert a normal table in a spreadsheet to a view that transfers data from an IBM Cognos Planning - Analyst D-Cube. You then maintain an existing report by specifying in detail how to use row, column, and page labels to transfer the data from Analyst.

You first start by adding row and column headings just as if you were creating a standard Excel spreadsheet. Then you log on to Analyst and define how to use the labels to transfer the data held in Analyst.

Defining a view gives you precise control over where data appears.

Steps

1. Open a new Excel worksheet.

2. Type the row labels Units sold, Unit Price, Sales, Margin, Overheads, and Profit, and the column labels Jan and Full Year, as shown in the following example:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Units sold</td>
<td>Jan</td>
<td>Full Year</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Unit Price</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sales</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Margin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Overheads</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Profit</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Add-in looks for an exact character match on the labels, including spaces and uppercase or lowercase characters. In the example, Units sold has the s of sold in lowercase, so it does not match the corresponding D-List item.

Tip: To ensure an exact match for the labels without typing the item names, from the Analyst menu, point to View and click Paste D-List Items. This displays the labels directly from the underlying D-Lists. You can even produce laminated row and column labels, formed from two or more D-Lists.

So far, all you have done is type labels in Excel. Now, you will specify the D-Cube that contains the data.

3. Click cell A1. From the Analyst menu, click View, Define View.

4. In the Analyst Define View 1 of 6 dialog box, select Profit and Loss from the tutorialgo library and click Next.

5. In the Analyst Define View 2 of 6 dialog box, enter the cell positions or ranges where the Analyst note, the page label, the row labels, and the column labels are to appear in your report, as shown in following example.
The ranges you enter for the row and column labels do not have to be exact if they encompass at least the range containing the labels you want to update. For example, if you want to define a view with a laminated dimension consisting of two sets of row labels, make sure that the range spans the entire range where the labels are to appear (multiple sets of row labels span more than one column).

6. Click Next.

7. In the Analyst Define View 3 of 6 dialog box, define the D-List to use for the row, column, and page labels.
   - In the upper left window, select Page D-List 1 of 1. In the upper right window, select 2 Divisions and Click Match.

The Add-in moves the selected items to their respective lower windows.
   - Match the row and column D-Lists as shown in the following example and then click Next.
If you have misspelled labels or unmatched items, the Analyst Define View 4 of 6 dialog box appears.

8. To correct a spelling error, select the misspelled label and its respective D-List item, in this case Units sold and Units Sold, and click Match.

Note: If the items differ only in the use of case, when you select the misspelled label, the Add-in automatically selects the respective D-List item.

9. Click Next.

10. In the Analyst Define View 5 of 6 dialog box, you can hide pages or sort them in the order you want them to appear in the Excel view. You are allowed to select only the pages at this point. In this chapter, move all pages to the Items included column and click Next.

11. In the Analyst Define View 6 of 6 dialog box, you can set the options for color coding and validation checks on refresh. Accept the default viewing options and click Finish.

For more information about the default viewing options, see "Options" (p. 68).
The Add-in transfers the data from the underlying D-Cube to the Excel view.

12. In the Excel view, select the range containing the data and format it to 1 decimal place.

```
<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Profit</td>
<td>and</td>
<td>Loss</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>American</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Jan</td>
<td>Full Year</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Units Sold</td>
<td>188280.0</td>
<td>296348.0</td>
</tr>
<tr>
<td>7</td>
<td>Unit Price</td>
<td>146.6</td>
<td>160.4</td>
</tr>
<tr>
<td>8</td>
<td>Sales</td>
<td>274 1168.5</td>
<td>41 103892.5</td>
</tr>
<tr>
<td>9</td>
<td>Margin</td>
<td>776847.2</td>
<td>11698563.3</td>
</tr>
<tr>
<td>10</td>
<td>Overhead</td>
<td>304967.5</td>
<td>37000000.0</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Profit</td>
<td>471679.7</td>
<td>7968563.3</td>
</tr>
</tbody>
</table>
```

Now that the view is set up, you can reselect the rows, columns, and pages.

13. From the Analyst menu, click Reselect View.


   All items in each D-List (2 Divisions, 1 Profit and Loss, and 4 Months - Fiscal) are dimmed and located in the Items included list. Click OK.

15. Save the file and name it Tutorial7.xls.


You have converted an existing Excel spreadsheet so that it uses the labels to transfer data from an Analyst D-Cube.
Chapter 9: Using Analyst Options

In this section, you make changes to a view of Tutorial6.xls and Tutorial7.xls by changing some of the display options in the Analyst View Options dialog box. Instead of starting from scratch with a new report, you adapt these two previously created reports to control the appearance and behavior of existing views in a workbook. The Analyst View Options dialog box shows the options applied to the currently selected view. You can change the view options for any of the other views in the workbook by selecting a different view name from the View Name text box.

Note: The default view options are changed from the Analyst menu by clicking Options. If you change the default options, you do not affect any existing views; you simply change the default options for all new views.

Access the Analyst View Options dialog box
Access the Analyst View Options dialog box to change the options.

Steps
1. In Excel open the Tutorial6.xls file.
2. From the Analyst menu, click View, Options. The Analyst View Options dialog box opens. The default options are currently selected.
   Note: Use caution when changing these settings in normal use. Some of them, like Treat blanks as zero on recalculate and Treat errors as zero on recalculate may affect the output of your view and should only be changed if it is necessary.
3. Click OK to close.

Using Formatting Options
Formatting options allow you to change features such as foreground and background cell colors.

Auto Color - Foreground Data Cells
With this check box selected, the detail and formula data cells change color when the numbers change with respect to the saved version of the underlying D-Cube. The detail and formula items change to purple and red, respectively.

Steps to Apply Auto Color to Foreground Data Cells
1. In the Tutorial6, sheet1 view, in cell C5 type 740.00, and then press Enter.
2. From the Analyst menu, click Recalculate, Selected View.
3. A message appears telling you there are unprocessed changes, asking if you want to process them. Click No.
4. Another message appears telling you the D-Cube tutorial go. New Sales may have changed since you last refreshed, and asks you whether you are sure you want to recalculate without refreshing first. Click Yes.

5. Cell B5 turns red, and Cell C5 turns purple.
The coloring is reapplied every time the view is refreshed or recalculated. If you want to use your own coloring, you must clear the Auto Color check boxes. The following table shows the default colors for foreground data cells.

<table>
<thead>
<tr>
<th>Cell Type</th>
<th>Text Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail</td>
<td>Blue</td>
</tr>
<tr>
<td>Formula</td>
<td>Black</td>
</tr>
<tr>
<td>Changed detail</td>
<td>Purple</td>
</tr>
<tr>
<td>Changed formula</td>
<td>Red</td>
</tr>
</tbody>
</table>

**Auto Color - Background Data Cells**

This check box affects the coloring applied to the background in data cells when cells are either locked, protected, or held. You will lock a range of cells in the underlying D-Cube and then try make a change in the Excel view to see how the auto color changes take effect.

**Steps to Apply Auto Color to Background Data Cells**

1. In Excel, if you are not logged on already to Analyst, from the Analyst menu, click Log On.
2. Start Analyst.
3. In Analyst, open the New Sales D-Cube. Ensure that Cooking Gear is displayed in the rows. If it is not, drag Cooking Gear down to the bottom Rows position.
4. Right-click Sleeping Bags and select **Lock**.

5. Save and close the D-Cube.


7. In the Excel view, in cell C7, change the number to 16000.00 and press Enter.

8. From the **Analyst** menu, click **Recalculate, Selected View**.

9. A message appears telling you the view contains unprocessed changes and asks if you want to process them now. Click **Yes**.

10. A second message appears telling you that the New Sales D-Cube may have been changed and asks if you want to recalculate without refreshing. Click **Yes**.

11. The value in the C7 cell, Sleeping Bags, does not change, and the background of the cell range turns light gray to indicate there is a lock on the cells.

The following table shows the default colors for background data cells.

<table>
<thead>
<tr>
<th>Cell Type</th>
<th>Cell Background Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked (prevents typing, and input via a D-Link)</td>
<td>Light gray</td>
</tr>
<tr>
<td>Protected (prevents typing)</td>
<td>Yellow</td>
</tr>
<tr>
<td>Held (prevents change on breakback)</td>
<td>Turquoise</td>
</tr>
<tr>
<td>Held and protected cells</td>
<td>Green</td>
</tr>
<tr>
<td>Held and locked cells</td>
<td>Dark gray</td>
</tr>
</tbody>
</table>
Auto Color - Foreground D-List Cells

This check box affects the coloring applied to the text in the row and column labels. If an item doesn’t match an item in the underlying D-List, the text turns red upon refresh.

Steps to Apply Auto Color to Foreground D-List Cells

1. From the Lyon view, double-click Jan and change it to January.
2. From the Analyst menu, click Refresh, Selected View.
3. A message appears telling you that the view contains incomplete totals. Click Yes.
4. January changes to red to indicate the label no longer matches the item in the underlying D-List.

The following table shows the default colors for foreground D-List cells.

<table>
<thead>
<tr>
<th>Cell Type</th>
<th>Cell Background Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail item</td>
<td>Blue</td>
</tr>
<tr>
<td>Formula item</td>
<td>Black</td>
</tr>
<tr>
<td>Item does not match an item in underlying D-List</td>
<td>Red</td>
</tr>
</tbody>
</table>

Note: This coloring is different from that applied to the row and column labels in Analyst, where coloring indicates whether data for an item has changed.

Auto Color - Background D-List Cells

This check box affects the coloring applied to the background of D-List cells when an item doesn’t match an item in the underlying D-List.

The following table shows the default color for background D-List cells and the condition when it is displayed.

<table>
<thead>
<tr>
<th>Cell Type</th>
<th>Cell Background Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item does not match an item in underlying D-List</td>
<td>Gray</td>
</tr>
</tbody>
</table>

Steps to Apply Auto Color to Background D-List Cells

1. From Analyst, click View, Options.
2. Select the Auto Color - Background D-List Cells check box, and click OK.
3. From the Analyst menu, click Refresh, Selected View.
4. A message appears telling you that the view contains incomplete totals. Click Yes.
5. The January cell background changes to grey to indicate the label no longer matches the item in the underlying D-List.

6. Clear the **Auto Color - Background D-List Cells** check box.

7. Save and close the Tutorial6.xls Excel file.

**Replicate Headings**

If you want to combine two or more D-Lists to make up the row or column labels, you can replicate the headings for the first set of labels. If the Replicate Headings check box is cleared, the first label displays as a subheading. This option is particularly useful when suppressing zero rows on refresh or when you want to sort or filter.

**Steps**

1. Open Tutorial1.xls.

2. From the **Analyst View Options** dialog box, select the **Replicate Headings** check box. Click **OK**.

3. From the **Analyst** menu, click **Refresh, Selected View**.

4. Close the file without saving.

**Suppress Zero Rows On Refresh**

Suppress rows with nothing but zeros to simplify the display.

**Steps**

1. Start Analyst.

2. From the tutorialgo library, open the New Sales D-Cube.

3. Ensure 2 Cities is on Pages, 2 Products in rows, and 4 Months - Calendar in columns. In the Jan cell of Cooking Gear row, type 0> and press Enter.

<table>
<thead>
<tr>
<th></th>
<th>Jan</th>
<th>Feb</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cooking Gear</td>
<td>0&gt;</td>
<td>15,377.56</td>
</tr>
<tr>
<td>Lents</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Sleeping Bags</td>
<td>15,781.50</td>
<td>92,391.50</td>
</tr>
<tr>
<td>DCell</td>
<td>43547.14</td>
<td>0.00</td>
</tr>
<tr>
<td>Lister</td>
<td>4,565.00</td>
<td>4,780.25</td>
</tr>
<tr>
<td>Cooking Equipment</td>
<td>97,465.82</td>
<td>92,659.02</td>
</tr>
</tbody>
</table>

Zero is entered in each cell of that row.

4. Save and close the D-Cube, and close Analyst.

5. Open tutorial6.xls.

6. In the Excel view, from the **Analyst** menu, click **Refresh, Selected View**. Every cell in the Cooking Gear row turns to zero except for the January column, which was changed earlier and doesn’t match the underlying D-List.
7. From the Analyst menu, click View, Options.
8. Select the Suppress zero rows on refresh check box and then click OK.
9. Again, from the Analyst menu, click Refresh, Selected View.
   Row 5 - Cooking Gear, disappears because all its values were set to zero.
10. From the Analyst View Options dialog box, clear the Suppress zero rows on refresh check box and click OK.

Using Advanced Options

The following options control advanced features. Many should only be used when you are certain that they are necessary.

Treat Blank Cells as Zero on Recalculate

In regular use, selecting this check box is not recommended unless you are certain that it is necessary.

Steps

1. Re-open Tutorial6 in Excel.
2. From the Analyst menu, click View, Options.
3. In the Analyst View Options dialog box, select the Treat blanks as zero on recalculate check box, and then click OK.
4. In the Excel view, double-click cell C8, delete the number, and press Enter.
5. From the Analyst menu, click Recalculate, Selected View.
   • A message appears stating the view contains unprocessed changes. Click No.
   • A second message appears stating that the D-Cube values may have been changed. Click Yes. The blank cell is now treated as zero.

Note: To display zero cells as blank cells, you do not have to select the Treat blank cells as zero on recalculate check box. There are two alternatives:

• To display zero values as blank cells for the entire workbook, on the Tools menu, click Options. In the Options dialog box, click the View tab. In the Window options area, clear the Zero values check box.

• To display zero values as blank cells on a cell by cell basis, use a custom number format such as #,##0;#,#0; (using the syntax: format for positive numbers; format for negative numbers; format for zero values).
Treat Errors as Zero on Recalculate

Checks the content of each cell in the active view for an Excel error code such as #VALUE!, #DIV/0!, ERR, or #NAME? When you recalculate, selecting this check box treats these cells as if a zero had been entered.

It is not recommended selecting this check box unless you are certain that it is necessary.

Allow Break-back on Recalculate

The Allow Break-back on recalculate option is selected by default. Allow Break-back on recalculate allows you to enter data in either detail or formula cells in Excel. Breakback splits a number entered in a total pro rata according to the previous values contained in the components of the total. This can be useful for allocating costs or for phasing a budget over months using a seasonality profile.

The Allow Break-Back on recalculate check box is automatically synchronized across views of a D-Cube in one workbook. For example, if you select this check box for one view, it is also selected for any other views in the workbook that use the same D-Cube. When you create a new view that uses a D-Cube already used by other views in the workbook, you cannot change the selection in the Analyst New View 5 of 5 dialog box. To change the setting, create the new view and from the Analyst menu, point to View and click Options.

If you clear the Allow Break-Back on recalculate check box, you should enter data only in detail cells. If you select the Auto Color check boxes, detail items are colored blue. Data entered in black formula cells is ignored.

Steps

1. In Excel, open the Tutorial7.xls file.

2. From the Analyst menu, click View, Options. From the Analyst View Options dialog box, make sure the Allow Break-back on recalculate check box is selected, and click OK.

3. Double-click cell O6 of the Units Sold row and type 512696 and press Enter.

4. From the Analyst menu, click Recalculate, Selected View.

5. A message appears stating the Profit and Loss D-Cube may have changed. Click Yes. The break-back calculation is performed. Notice all numbers associated with Full Year of Units Sold have been doubled.

6. Close the view without saving.

Allow Break-back from Excel Formula

If you select the Allow Break-back from Excel formula check box, the results of Excel formulas are sent to Analyst formula items on recalculation, causing a breakback.

The default setting is cleared to avoid breakbacks that can occur if the Excel formulas are not mathematically identical to those in the D-Lists.

You cannot clear this check box if the Allow Break-back on recalculate check box is also cleared.
Overwrite Excel formula on refresh

You can select this check box to ensure that the formula results shown in Excel are the same as those in the D-Cube. For example, if you clear this check box and enter the number 50 in a cell, expressed as =30+20, when you recalculate, the number 50 is sent to the D-Cube. However, on refresh, the formula is not overwritten even if the number in the D-Cube is no longer 50.

If you select this check box, the program overwrites Excel formulas only when the labels are an exact character match of existing D-List items and within the ranges that define the row and column labels. It does not overwrite Excel formulas entered for custom items (where the labels do not match a D-List item).

Blank invalid data cells if note present

If you delete or rename D-List items, the labels in Excel might become invalid. Selecting this check box blanks out any data in invalid rows, columns, and pages when the view is refreshed.

Data present for custom items is not blanked out. The distinction is made using cell notes; cells without a note are assumed to be custom items because only those items that were once valid have a note.

If you clear this check box, the data held against invalid items remains unaffected when you refresh the view. This check box is not active if the Check for unmatched items check box is cleared.

Validity Checks

You can check for labels or totals that no longer match any item in the D-Lists. Since creating the view, items might have been renamed in Excel or Analyst, deleted entirely from the D-List, or totals may have changed.

By default, both Check for unmatched items, and Check for incomplete totals are selected.

Check for Unmatched Items

Whenever you refresh or recalculate a view, the program verifies that the row, column, and page labels in the view are up to date and match. If the labels are not up to date, you receive a warning message.

Steps to Update the View with a Changed Label
1. Open the Tutorial7, Northern Europe view.
2. Change Sales to Sale and press Enter.
3. From the Analyst menu, click Auditing, Check View for renamed D-List items or, from the Analyst menu, click Reselect View.
4. The Analyst Update D-List Items dialog box opens and allows you to change the spelling of items that have been renamed in the D-List or in Excel.
5. Click Sale and then Sales and then click Match. Click OK. A message appears stating that the D-List items have been updated, and that you should refresh the view. Click OK.
Using Check for Unmatched Items

This feature relies on the presence of cell comments (called notes in earlier releases of Excel) in the row and column labels. The comment attached to each label contains the name of its D-List. The presence of a comment is indicated by a small red triangle at the upper right of each cell. When you create a new view, all labels are provided with the appropriate cell comment. If, at a later date, the program finds a label with a comment that does not match a D-List item, a warning message appears. The program automatically applies the appropriate comment to any new matching items that it finds, even if you added the items manually. However, if you add an item that does not match a D-List item, the program assumes that this is a custom item (that is, not found in the D-List), and does not apply a comment. The program does not warn you that the item does not match a D-List item, and the item does not appear in the Update D-List Items dialog box.

You can either manually or automatically include an item without a comment in the validity checking.

To manually include an item, on the Edit menu, click Copy; or on the Edit menu, click Paste Special. In the Paste Special dialog box in the Paste area, select the Comments option and click OK.

To automatically include an item, in the Analyst View Options dialog box, clear the Check for unmatched items check box and then select it. This applies a comment to all row and column labels. To match up the invalid items, from the Analyst menu, point to Auditing and click Check View for renamed D-List items. The program removes the comments for any items left unmatched, thus converting them to custom items. Optional. If you do not want to be warned that an item is invalid and want to remove cell comments manually, on the Edit menu, point to Clear and click Comments.

To hide cell comments but still take advantage of the Check for unmatched items option, on the Tools menu, click Options. In the Options dialog box, click the View tab. In the Comments area, select the None option.

You can clear this validity check, but since it is important that the view reflects the latest data held in the underlying D-Cube, we do not recommend it.

There are other indications of unmatched items. If you select the Blank invalid data cells if note present check box, data is removed from any invalid items containing a comment when the view is refreshed. If you select any of the Auto Color D-List Cells check boxes, invalid items are colored. Remember, however, that this coloring is applied to invalid D-List items (items with a comment) and custom items (non matching items with no comment).

Check for Incomplete Totals

To display a warning if items are missing from subtotals or formulas in your current selection, select the Check for incomplete totals check box (it is selected by default). This allows you to detect if new items have been inserted into subtotals in the D-List since you last refreshed the view or if you have accidentally left items out. This is checked every time you recalculate or refresh.

You might need to clear this check box if you deliberately selected subtotals or formulas without their component detail items. For example, you might want to ensure that you have all the items that make up a particular subtotal in a view, even if you do not want the subtotal itself in the view. In this case, you can include the relevant subtotal in the view and hide the row or column in Excel.
To ensure that every component of a subtotal is included, from the Analyst menu, click Reselect View. In the Analyst Reselect D-List Items dialog box, select all items in the Items included list on the right and click the Expand button. This selects the missing items on the Items excluded list on the left. Click the right arrow button to move the items to the Items included list.

**Action on Opening Workbook**

These options affect the behavior of views when the workbook containing the views is opened.

**Refresh View on Loading**

Automatically updates the numbers in a view from the underlying D-Cube as soon as you open the workbook.

This option is useful for ensuring that the data in a view is up to date. However, there are cases where it is inappropriate. For example, if you edited the numbers in a view when you were not connected to Analyst, selecting the Refresh View on Loading check box risks losing those numbers.

This option is automatically synchronized across views of a D-Cube in one workbook. For example, if the check box is selected for one view, it is also selected for any other views in the workbook that use the same D-Cube. When you create a new view that uses a D-Cube already used by other views in the workbook, you cannot change the selection in the Analyst New View 5 of 5 dialog box. To change the setting, create the new view and, from the Analyst menu, point to View and click Options.

You also can click the Read Write Access command from the Analyst menu to edit the setting for all views that use a D-Cube.

Remember that refreshing updates the data, not the labels. It does not refresh the row or column labels to reflect renaming, addition, or deletion of items. Excel formulas are not overwritten by refreshing unless you have selected the Overwrite Excel formula on refresh check box.

**Get Write Access on Loading**

Used in a multi-user environment, this option automatically attempts to get write access to the appropriate D-Cube when you open the workbook. This allows you to enter data into the underlying D-Cube. However, selecting this check box does not force another user off if they are already entering data and have write access.

This option is synchronized across views of a D-Cube in one workbook.
Appendix A: The Analyst Menu in Excel

The Analyst menu provides all of the Analyst related functionality that you can use within Excel.

Refresh

You can refresh Excel views to ensure that they are updated with the latest data held in IBM Cognos Planning - Analyst.

Refreshing a view transfers the latest data into any cell where the row, column, and page labels match the underlying D-List items exactly. The matching process is case sensitive and refreshes the numbers instead of the labels. Unprocessed entries are overwritten.

From the Analyst menu, click Refresh. You can refresh Views of D-Cube, Selected View, or All Views.

Generally, the Refresh commands use the formulas in Analyst to calculate the results. However, you can preserve cells with Excel formulas entered, such as =30+20. From the Analyst menu, point to View and click Options. In the Analyst View Options dialog box, clear the Overwrite Excel formula on refresh check box.

Refreshing applies only to data. The row or column labels are not refreshed to reflect renaming, adding, or deleting items. If you select the Auto Color check boxes, unmatched items display in red to show that they no longer match a D-List item.

Refresh Views of D-Cube

You can refresh the active view (where the cursor is) and all other views of the same D-Cube in the workbook with the latest values held in Analyst.

Refresh Selected View

You can refresh the active view only (where the cursor is) by transferring the latest data from Analyst. This does not refresh any other views in the workbook.

Refresh All Views

You can refresh all views in the active workbook with the latest values held in Analyst.

You can perform a partial refresh by entering a colon (:) in cells that you want to refresh and recalculating the view. The colon acts as a null operator, meaning do nothing. It refreshes cells with colons and recalculates any other cells. To target multiple cells, select the desired range, type a colon in any one cell, then press CTRL + ENTER.
Recalculate

You can process the numbers entered in an Excel view.

Steps
1. From the Analyst menu, click Recalculate, Selected View or All Views. This sends the numbers back to the underlying D-Cube and uses the formulas held in Analyst to calculate the results.
2. After recalculation, the results are saved in Analyst only if you click Save D-Cube from the Analyst menu.

Recalculation Rules
If the active view of the D-Cube has been customized within Excel, the following rules apply when recalculating.

- Rows, columns, or pages that are not an exact character match of a D-List item are ignored. The matching process is case sensitive.
- If other views of the same D-Cube overlap, both views are recalculated. If you inadvertently target the same cell with conflicting numbers, the earlier named view takes priority. You can view the view name and number (for example, analyst_view_1) by, from the Analyst menu, pointing to View and clicking Options.
- Unless you have defined an Excel formula, recalculating uses the formulas defined in Analyst to calculate the results. Excel formulas entered in a cell, such as = 30 + 20, are overwritten unless, from the Analyst menu, you click Options and clear the Overwrite Excel formula on refresh check box. The Excel formulas in custom items (items that do not match a D-List item) are unaffected whether this check box is cleared or selected.
- Breakback operates unless, from the Analyst menu, you click Options and clear the Allow Break-back on recalculate check box.
- The default recalculation mode does not send the results of Excel formulas to matching Analyst formula items. This avoids breakbacks that can occur if the Excel formulas are not mathematically identical to those in the D-Lists. You can change this selecting the Allow Break-back from Excel formula check box.
- If the Auto Color check boxes are selected, the numbers display in red to indicate that they have changed. Invalid items display in red (or red on grey) to show that they no longer match a D-List item.
- If the workbook and worksheet are not password protected, protected cells are overwritten and remain protected. If the worksheet is password protected, they are not overwritten.

Recalculate Selected View
You can recalculate based on the data in the Excel view. If other dependent views of the same D-Cube in the workbook contain unprocessed entries, you are asked whether you want to recalculate.
or refresh these views. A dependent view is one in which the selection of rows, columns, or pages
overlaps the other view or is dependent on the other view by means of a formula in the underlying
D-List.

**Recalculate All Views**

You can process the numbers you have just typed into the current view in Excel and recalculate all
views of all D-Cubes in the workbook.

**Reselect View**

You can reselect the items that make up the rows, columns, and pages of the current view.

**Steps**

1. From the **Analyst** menu, click **Reselect View**.

   If items have been renamed or deleted since you last refreshed your report, this command first
   opens the Analyst Update D-List Items dialog box so you can match the old labels against the
   renamed D-List items. If all items in your selection are valid, this command opens the Analyst
   Reselect D-List Items dialog box.

2. After you finish renaming, the **Analyst Reselect D-List Items** dialog box opens. This dialog box
   allows you to insert, reorder, or delete rows, columns, and pages in the Excel view. On the
   right are D-List items included in the current view; on the left are those that currently are
   excluded but are available for selection.

**Save D-Cube**

To save the current values of the underlying D-Cube in Analyst, from the **Analyst** menu, click **Save
D-Cube** and select the D-Cubes to save. If you have unprocessed entries, you are prompted to
recalculate before saving.

The Analyst Save D-Cube dialog box shows only those D-Cubes with unsaved changes. Because
you can save each D-Cube individually, you might have to click Save several times if you have views
from several D-Cubes in your Excel file. When finished, click **Close**.

**Reset D-Cube**

You can reset the D-Cube in Analyst back to the saved version and then refresh the active Excel
view by, from the **Analyst** menu, clicking **Reset D-Cube**. The Reset D-Cube command also refreshes
any other view in the workbook that uses the same D-Cube. This command does not, however,
reset the spelling or selection of row and column labels, nor does it reset views of other D-Cubes.

If you want to keep some of your changes, select and copy them to an unused part of the worksheet
before running this command. After the data is restored, copy your changes back into the active
view and recalculate.
Appendix A: The Analyst Menu in Excel

Read Write Access

To view the current access status, from the Analyst menu, click Read Write Access. Generally, the read/write access settings are relevant only when multiple users try to enter data in the same D-Cube simultaneously. Write access allows you to save changes back to a D-Cube. It is available to only one user at a time. Click the Release button to allow someone else to have write access.

If two users try to write to non-overlapping selections, they still cannot both write to the D-Cube because the settings apply to the entire D-Cube, not just part of it.

You can gain write access automatically on opening the Excel file and logging on to Analyst for Excel. If you always want to enter data in the Excel view, you must select the Get Write Access on Loading check box. The default setting for both check boxes is cleared.

If an Excel workbook contains views from several D-Cubes, you must set these check boxes separately for each D-Cube. However, if there are several views from the same D-Cube, after you set it for one view, it applies to all other views.

The Analyst Read/Write Access dialog box does not allow you to change the security settings. You can gain write access only if you initially had sufficient access rights in Analyst.

Batch Printing

Batch printing is a two-stage process in which you first copy the current view onto a series of separate worksheets (one page for each worksheet), and then print the worksheets. Each new worksheet becomes a separate view of the same D-Cube. You can apply the formatting before or after creating the sheets. If you apply formatting before creating the sheets, it takes longer to produce but is easier to maintain.

Print Sheets

You can view a sample of the sheets before printing with the Print Preview option.

You should always use the Page Setup option on the File menu before printing the sheets (from the Analyst menu, click Batch Printing, Print Sheets). The Page Setup option allows you to set the page orientation (portrait or landscape) and the fit-to-page settings for all sheets at once. After you are in Print Preview mode, you can change these settings only one sheet at a time.

Drill Down

To analyze the contents of a cell, from the Analyst menu, click Drill Down. This displays all the D-Links targeting a D-Cube. You then can choose a D-Link and drill down to find the components, if any, that went into the target cell. You should select only one cell to drill down from at a time.

If you select a range, only the first cell is considered.

Click the D-Link name in the upper window and then click OK. The items appear in a normal view on a separate sheet. If there is no relevant D-Link, there is nowhere to drill down to and no result appears.

If the drill down produces a result that is different from that displayed in the target cell, it usually means that the D-Link has not been run recently. Drill down can analyze several D-Links at a time.
The lower window contains a list of D-Links from external sources such as ASCII files or ODBC links. You cannot drill down to these D-Links. This list is for information only.

**Pick Item from D-List**

In rows and columns that have been D-List items formatted in the underlying D-Cube, you can enter text corresponding to items in a D-List. From the **Analyst** menu, click **Pick Item from D-List**. This command does not apply to items that have been formatted to accept free text. You must be logged on to Analyst to use this facility.

**Run Macro**

Runs an Analyst macro. From the **Analyst** menu, click **Run, Macro**. In the Select Analyst Macro to Run dialog box, select an available macro from the Macro list and click **OK**.

**Run D-Link**

Runs an Analyst D-Link. From the **Analyst** menu, click **Run, D-Link**. In the Select a DLink dialog box, select an available D-Link from the D-Link list and click **OK**. The available D-Links target the D-Cube in the active view.

**New View**

Creates a new view in Excel based on the data held in a D-Cube in Excel. You are allowed several views of the same or different D-Cubes on each worksheet. You can have several worksheets in an Excel file.

**Additional View Options for New Views**

In addition to the standard view options, the View Style, Analyst cell, and View name suffix options are provided in the Analyst New View 4 of 5 dialog box.

**Views**

You copy or delete a view, as well as change the display options or create a new view.

**Copy Views**

You can copy the active view, one view at a time, to anywhere else in the workbook. From the **Analyst** menu, click **View, Copy**. In the Analyst Copy View dialog box, type the destination cell for the view and click **OK**.

The copied view is given a new range name. For example, if you copy Sheet1!Analyst_view_1 to a separate worksheet, it is given a name such as Sheet2!Analyst_view_1. If you copy the Sheet1!Analyst_view_1 to the same worksheet, it is given a name such as Sheet1!Analyst_view_2.
Delete Views

Use the following steps to delete a view.

**Steps**

1. Click anywhere in the view to make it active.
2. From the Analyst menu, point to View and click Delete.
3. A message appears asking if you are sure you want to delete the view. Click Yes.

The deleted area is defined by the ranges of the row, column, and page labels. Other views of the same or different D-Cubes are unaffected.

Display Options for Views

You can change the display options for any of the views in your workbook, including formatting options, advanced options, validity checks, and actions on opening workbook.

Define View

The Define View command allows you to convert part of an existing Excel spreadsheet to a view from an Analyst D-Cube. This command also allows you to edit, repair, or convert an existing view.

Paste D-List Items

You can paste a list of items copied from a D-List into your spreadsheet.

**Steps**

1. From the Analyst menu, point to View and click Paste D-List Items.
2. In the Analyst Paste D-List 1 of 4 dialog box, select the name of the D-Cube and library from which to copy the D-List items and click Next.
3. In the Analyst Paste D-List 2 of 4 dialog box, move the D-Lists you want to the Included D-Lists window and click Next.

   Usually, you would leave only one D-List in the Included D-Lists window. This D-List would form either the rows or columns of the table (you cannot create both rows and columns in one operation). However, when you want to combine two or more D-Lists to create a laminated row or column dimension, you can select more than one D-List.

4. Optional. In the Analyst Paste D-List 3 of 4 dialog box, reorder and exclude D-List items as desired.

   The default mode is to select all items in D-List order.

5. Click Next.

6. In the Analyst Paste D-List 4 of 4 dialog box in the Start cell text box, type the cell reference for the first item in the D-List.
7. In the Direction to paste the D-Lists area, select whether to paste the D-List items vertically as row labels (Rows) or horizontally as column headings (Columns).

8. To repeat the item labels, select the Replicate Headings check box. This option applies only to laminated dimensions.

9. To paste the D-List into the spreadsheet, click Finish.

10. To insert D-List items for page labels, from the Analyst menu, point to View and click Define View. You then can select the pages to include in the view.

   The Add-in automatically inserts a drop-down menu for the page labels.

**Resize all drop downs to fit cells**

You can resize a drop-down menu containing a page label so that it fits the cell that contains it. This option is for appearance only.

For long page labels, you might need to resize or move the drop-down menu so that you can see the full label. Press CTRL and click the page label, then resize the label by dragging the handles. You can move the drop-down menus anywhere in the worksheet. It is the text underneath that defines the page labels, not the drop-down menu itself.

**AutoFormat**

Analyst for Excel uses the standard Microsoft Excel auto-formats.

When you click View, AutoFormat from the Analyst menu, the following options are available: Number, Font, Alignment, Border, Patterns, and Width/Height. You may also choose from 16 standard Excel table formats to display D-Cube information in Excel.

**Note:** You must choose at least one format option. You can apply more of these options at a later date, but you can’t de-select these options retrospectively.

**Auditing**

The Auditing menu commands allow you to verify that a report is up to date and accurate. As well as refreshing the view with the latest data held in Analyst, you can check for items that were renamed, deleted, inserted, moved, or put in a different subtotal in an underlying D-List. You also can check to see if the object names contained in the notes and referred to by buttons were renamed. You can update the names for the following Analyst objects: systems, libraries, D-Cubes, D-Lists, D-Links, and macros.

**Check View for renamed D-List items**

Use this command to identify unmatched items and rename or delete them.

**Steps**

1. From the Analyst menu, point to Auditing and click Check View for renamed D-List items.

   The Analyst Update D-List Items dialog box appears and displays all unmatched items within the ranges defined for the row, column, and page labels that do not match an existing D-List.
item. The **Unmatched Items** window shows the items in the D-List that are not included in the view. This comprises new items, renamed items, and items that were never part of the current selection.

2. To rename the item in Excel, select the invalid item in the upper left window and the corresponding item on the right. To move the pair of items to the **Matched Items** window, click **Match**.

3. Repeat step 2 for each D-List in turn and click **OK**.

4. If you have items that no longer match, you can delete them by selecting the invalid item(s) in the upper left window and clicking **Delete** to move the item(s) to the **Deleted items** window.

5. To insert new items, from the **Analyst** menu, click **Reselect View**.

---

**Show Precedents of Formula**

Allows you to check a selection for missing items and for invalid items contained in formulas. The selection should contain both the label containing the formula and its precedents (a precedent is a variable used to calculate the formula result).

You can copy invalid or superfluous items that have been identified by the audit checks to the Windows clipboard by clicking Copy and pasting the item to a blank area of the spreadsheet. You then can use the items to correct the existing labels.

---

**Check Integrity of Views**

Checks all named ranges in the workbook. If they are related to Analyst, the Add-in verifies that the ranges are valid and removes those that are no longer used. This command provides a useful way to clean up the range names in a workbook.

---

**Check Active View for Errors**

Checks the content of each cell in the active view for an Excel error code such as #VALUE!, #DIV/0!, ERR, or #NAME?. The search occurs in row order, starting from the top left. The first cell found with an error code becomes the active cell to enable you to change the value.

---

**Check Active View for Blanks**

Checks the active view for blank cells. The search occurs in row order, starting from the top left. The first blank cell found becomes the active cell to enable you to change the value.

---

**Replace object names in all definitions**

Replaces a text string throughout the workbook in all the Analyst notes and all the buttons, text boxes, arrows, and other objects that have Analyst actions assigned to them. This is useful if the system name, a library, a D-Cube, or a D-List has been renamed in Analyst but not in Excel. If you do not update the text in the note, an error occurs when you refresh or recalculate.

You can update the names of the following Analyst objects: systems, libraries, D-Cubes, D-Lists, D-Links, and Analyst macros. The names are all case sensitive.
Assign Action

You can assign actions to arrows, bitmaps, buttons, or text boxes.

For certain actions that refer to a particular view, the name of the sheet is incorporated in the text. In these cases, if you rename a worksheet, you must edit the text at the bottom of each text box or button to refer to the new sheet name. If the name of the system, library, D-Cube, D-Link, D-List, or Analyst macro changes, to ensure that the buttons, text boxes, or other objects continue to function with the new names, from the Analyst menu, click Auditing, Replace object names in all definitions.

Refresh

Assigns the Refresh action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action refreshes the selected view and any other views of the same D-Cube.

Recalculate

Assigns the Recalculate action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action recalculates the current view using the formulas held in the D-Lists. If there is more than one view of a D-Cube in the workbook, this action recalculates the current view and then refreshes the other views from the same D-Cube.

Get Write Access

Assigns the Get Write Access action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action gets write access for a selected D-Cube to prevent other users from writing to it while you are making changes.

Release Write Access

Assigns the Release Write Access action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action releases write access for a selected D-Cube.

Save

Assigns the Save action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action recalculates the data and then saves the data in the current view back to the D-Cube.

Print

Assigns the Print action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action runs the Batch Printing command to print the selected view.
Appendix A: The Analyst Menu in Excel

Run Macro
Assigns the Run Macro action to an object such as a text box, button, bitmap, or arrow. If you do not select an object, the Add-in creates a text box. This action runs the specified Analyst macro.

Note: This option does not run an Excel macro. To run an Excel macro, right-click an object and click Assign Macro.

Run D-Link
Assigns the Run D-Link action to an object such as a text box, button, bitmap, or arrow. If you do not select an object, the Add-in creates a text box. This action runs the specified Analyst D-Link.

Log On
Assigns the Log On action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action logs you on to Analyst.

Log Off
Assigns the Log Off action to an object such as a text box, button, or bitmap. If you do not select an object, the Add-in creates a text box. This action logs you off Analyst.

Options
To set the default options for all new views, from the Analyst menu, click Options. The Analyst Default Options dialog box displays the standard default settings.

The settings are applied to all views created in the future, but they do not affect any existing views. To change the settings for existing views, from the Analyst menu, click View, Options (where there is a Load Defaults button).

The settings in the Analyst Default Options dialog box are identical to those in the Analyst View Options dialog box, with the exception of the Analyst System Messages option.

Help
Analyst for Excel has a built-in Help system. The Help system contains topics explaining how to use Analyst for Excel. To access the Help system, from the Analyst menu, click Help.

You can access context-sensitive help by clicking the Help button in each dialog box.

About
To see which version of Analyst for Excel and Analyst you have installed, from the Analyst menu, click About. This command also displays the path name for Analyst for Excel (for example, C:\Program Files\Microsoft Office\Office\Library\Analyst.xla), the server you are connected to, and the session handle.
Appendix B: Reference

Appendix B provides additional information that was referenced in the tutorial.

Inserting Rows or Columns as the First or Last Item in the List

You can insert and reorder items by clicking Reselect View on the Analyst menu. However, when you insert rows or columns manually, make sure you do not insert items at the beginning or end of the list, or you might inadvertently go outside the range where IBM Cognos Planning - Analyst for Excel looks to find the labels. Excel amends the range if you insert a row or column in the middle of a list, but not if you insert a row or column at the edges, just outside the existing range.

To change the range, on the Insert menu, point to Name and click Define. In the Define Name dialog box, click analyst_row_1 and click OK.

Change the range it refers to so that it includes all row labels including the new label in cell A4:

```
analyst_row_1=Sheet1!$A$4:$A$22
```

The next time you point to Refresh and click Selected View from the Analyst menu, the labels in cell A4 are found and the data updates correctly.

Laminated Dimensions

A laminated dimension is created when you include row or column labels from two or more D-Lists. You must not insert a column between laminated row or column labels.

When the first row label or column label is a subheading, do not type anything into the blank cells beneath it. The program uses the first non-blank cell above the current position as the subheading.

Page Label Drop-Down Menu

The drop-down menu at the upper left of a table provides a list of all the pages in the current selection. When you change a page by selecting a different item from the drop-down menu, a different set of data is transferred from IBM Cognos Planning - Analyst into the current worksheet.

This drop-down menu allows you to change the text in the cell underneath it. It is actually the text written in the cell underneath that defines the page that is displayed, not the menu itself. This text is referred to by the range name, analyst_page_x, contained in the note in the Analyst cell.

You can move the page label box to a different part of the screen so that formatting can be applied to the page text.

You can also size or move the drop-down menu. To size the menu, press CTRL and click the menu, then drag the border handles. To move the menu, put the cursor over the menu until a four-headed arrow appears; then click the menu and drag it to the desired position.
Sharing Pages

When you have two views with the same D-Lists as page labels, you can set the labels to scroll simultaneously. This is achieved by creating a formula to set the page label text of one view to be equal to the page label text of the other view.

To set the text of the page labels as equal, delete the drop-down menu for one of the views. To delete the menu, press CTRL and click the menu and then press DELETE. Next, set up a normal Excel formula that refers to the page label text underneath the drop-down menu in the other view.

If there are two or more page labels, you can set one or both to scroll simultaneously using formulas to refer to the text underneath the drop-down menus.

To cease sharing pages, move the cursor to the page label text of the view that does not have the drop-down menu and delete the formula. To insert a drop-down menu in its place, on the Analyst menu, point to View and click Define View. A new drop-down menu is inserted in the position you choose for the page labels.

Analyst Macro List

If you view the list of available macros from within the Visual Basic Editor, you will see a large number of names. Most of these are internal macros that you cannot safely use; we do not guarantee that they will continue to exist in future releases of IBM Cognos Planning - Analyst for Excel. You should use only the macros described in the following table.

<table>
<thead>
<tr>
<th>Macro name</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst_CubeRefresh</td>
<td>Library name, D-Link name</td>
<td>Refresh the current view.</td>
</tr>
<tr>
<td>Analyst_CubeUpdate</td>
<td>Library name, macro name</td>
<td>Update the current view.</td>
</tr>
<tr>
<td>Analyst_RunDLink</td>
<td>Library name, D-Link name</td>
<td>Run a named D-Link.</td>
</tr>
<tr>
<td>Analyst_RunMacro</td>
<td>Library name, macro name</td>
<td>Run a named Analyst macro.</td>
</tr>
</tbody>
</table>

The following example shows a macro that runs the ProfitAndLoss>AmericasOverheads D-Link and then executes the Open Profit and Loss macro in Analyst. The name of the library containing the D-Link and the Analyst macro is tutorialgo.

```vba
Sub Company_update()
    Application.Run "Analyst_DLinkExecute", "tutorialgo", "ProfitAndLoss>AmericasOverheads"
    Application.Run "Analyst_MacroExecute", "tutorialgo", "Open Profit and Loss"
End Sub
```

To see which macro is assigned to an object, right-click the object and then click Assign Macro. The Assign Macro dialog box appears and displays the name of the macro referred to by the object.
If a macro does not run, check that the name of the library, D-Link, D-Cube, or Analyst macro has not changed since the macro was created. Names referred to in the macro are case sensitive.

## Visual Basic Commands

The following Visual Basic commands can be used in Excel macros. The exact syntax might vary depending on your version of Excel.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workbooks.Open &quot;C:\Test\Test.xls&quot;</td>
<td>Open an Excel file.</td>
</tr>
<tr>
<td>Sheets(&quot;Sheet1&quot;).Select</td>
<td>Make Sheet1 the active sheet.</td>
</tr>
<tr>
<td>Range(&quot;A1&quot;).Select</td>
<td>Make A1 the active cell.</td>
</tr>
<tr>
<td>ActiveCell.Value=&quot;99&quot;</td>
<td>Set the contents of the active cell to 99.</td>
</tr>
<tr>
<td>For i = 1 To 3</td>
<td>Print sheets 1 to 3.</td>
</tr>
<tr>
<td>Sheets(I).PrintOut</td>
<td></td>
</tr>
<tr>
<td>Next i</td>
<td></td>
</tr>
<tr>
<td>For i = 3 To 1 Step -1</td>
<td>Print sheets 1 to 3 in reverse print order.</td>
</tr>
<tr>
<td>Sheets(i).PrintOut</td>
<td></td>
</tr>
<tr>
<td>Next i</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You can continue long lines by ending them with a space and an underscore (\_) character. You can insert comments by preceding them with a single quote character (’).  

The following example shows a macro that opens another Excel file and prints sheets 1 to 3 in reverse print order.

```vba
' Macro1 Macro
'
Sub Macro1()
    Workbooks.Open "c:\test\test.xls"
    For i = 3 To 1 Step -1
        Sheets(i).Select
        Sheets(i).PrintOut
    Next i
End Sub
```

## Print Macros

More advanced users might want to record and edit their own print macro. This allows you to select precisely which pages to print by editing the page names in the macro.
For example, the following macro prints pages Jan, Feb, and Year but skips all the pages in the middle. To create this macro, first record a macro that prints a single page (on the Tools menu, point to Macro and click Record New Macro). Then, edit the macro to print the desired pages (on the Tools menu, point to Macro and click Macros. In the Macro dialog box, click the desired macro name and then click Edit).

' MacroPrint Macro
' Macro recorded 9/22/05 by Cognos Corporation.
'
Sub MacroPrint()
    Pagestoprint = Array("Jan", "Feb", "Year")
    For Each Page In Pagestoprint
        Range("analyst_page_1").Select
        ActiveCell.Value = page
        Application.Run "Analyst_CubeRefresh"
        ActiveWindow.SelectedSheets.PrintOut
    Next page
End Sub

Note: Range("analyst_page_1"). Select is used to select the cell in which to enter the page name. The cell containing the page label Range(A2). Select would also enter the page name, but it is safer to use the range names found in the Analyst note rather than cell references that might change as the table is moved.

The macro shown in the example selects the cell containing the page label, sets the text in that cell to the first page name, refreshes the view from the D-Cube, and then prints the entire sheet. The macro then repeats these actions for each of the page names typed into the Pagestoprint array.
Index

A
about
  versions, 68
access rights, 62
allowing breakback
  from Microsoft Excel formulas, 55
  on recalculating, 55
assigning actions
  get write access, 67
  log off, 68
  log on, 68
  print, 67
  recalculate, 67
  refresh, 67
  releasing write access, 67
  run D-Link, 68
  run macro, 68
  save, 67
auditing, 18, 50, 65
  checking active view for blanks, 66
  checking active view for errors, 66
  checking integrity of views, 66
  copying invalid items, 66
  copying new items, 66
  replacing object names in all definitions, 66
  showing precedents of formulas, 66
auto colour
  background data cells, 50
  background D-List cells, 52
  foreground data cells, 49
  foreground D-List cells, 52

B
batch printing, 62, 71
  data, 40
  printing report, 43
  printing sheets, 62
  select existing pages, 40
  sheets, 62
  best practices, 7
blank invalid data cells, 56
blanks
  checking for, 66
C
changing D-Cubes, 35
checking
  active view for blanks, 66
  active view for errors, 66
  incomplete totals, 57
  integrity of views, 66
  unmatched items, 56
checking view
  renamed D-List items, 65
colon, 13
colour conventions
  red on grey (invalid), 38
columns
  defining, 45
  deleting, 36
  errors, 18, 50, 69
  inserting, 36, 39
  laminated, 69
  renaming, 39
  selecting, 11, 17
  sorting, 40
  updating from D-Lists, 18, 50
copying
  invalid items, 66
  new items, 66
  views, 63
creating
  new view, 11, 40
custom items, 33
  converting, 56
  inserting, 33
D
data
  batch printing, 40
data entry templates, 49
Index

D-Cubes
   changing, 35
   renaming, 35, 66
   replacing name, 38
   resetting, 61
   saving, 61
define view, 64
   command, 45
   D-Cube, 45
   rows, columns, pages, 45
definitions
   replacing text, 66
deleting
   data in invalid cells, 56
   D-List items, 36
D-Links
   assigning actions, 68
   running, 26, 63
D-Lists
   changing and deleting items, 36
   D-List formats, 63
   inserting new items, 39
   laminated, 69
   picking items from, 63
   renaming, 66
   renaming and deleting, 39
   reordering, 37
   selection, 11, 17
   sorting items, 40
drop-down menus, 69
   moving, 65
   resizing, 65
   sharing, 70
dynamic selections, 17
   using detailed selection, 17
   using entire cube, 20
   using saved selection, 18

E
entire cube
   dynamic selections, 20
entire D-List
   dynamic selections, 17
errors
   #VALUE!, #DIV/0!, #NAME, 55
   audit checks, 18, 50
   cannot find a name, 66
   checking active view for errors, 66
   checking for incomplete totals, 57
   checking for unmatched items, 56
   treating as zeros, 55

F
fitting to page, 62
formats
   D-List formats, 63
   formatting options, 49
formulas
   checking for incomplete totals, 57
   custom formulas, 33
   overwriting, 56
   showing precedents of, 66
   total products, 40

G
getting write access
   assigning actions, 67
   on loading, 62

H
headings
   replicating, 53
   hiding notes, 56
   hierarchical tables, 31
      switching to normal, 31
   hierarchical view
      creating, 31
      inserting custom items, 33

I
inserting
   D-List items, 36, 39
   rows, columns, pages, 36, 39
   rows, columns as first or last, 69

L
labels
   updating, 38
   laminated rows and columns
      replicating headings, 53
libraries
   renaming, 66
log off
  assigning actions, 68
log on
  Analyst, 11
  assigning actions, 68
M
macros, 70
  Analyst list, 70
  assigning actions, 68
  example, 71
  printing, 71
  renaming, 66
  running, 63
Microsoft Excel report
  saving, 15
multiple views, 23
N
new view
  Hierarchical, 31
  normal, 11, 18, 23
  Pivot Table, 29
new views, 63
normal view, 23
notes
  defining, 45
  hiding, 56
O
options
  allowing breakback from Microsoft Excel formulas, 55
  allowing breakback on recalculating, 55
  blank invalid data cells, 56
  changing the defaults, 68
  checking for incomplete totals, 57
  overwriting Microsoft Excel formulas, 56
  refreshing views on loading, 58
  suppressing zero rows, 53
  treating errors as zero, 55
orientation, 62
overwriting Microsoft Excel formulas on refresh, 56
P
pages
  defining, 45
  deleting, 36
  errors, 18, 50
  fit to page, 62
  inserting, 36, 39
  moving page label boxes, 65
  orientation, 62
  page label boxes, 69
  page setup, 62
  renaming, 39
  resizing page label boxes, 65
  selecting, 11, 17
  sharing, 24, 70
  simultaneous scrolling, 24
  sorting, 40
page scrolling
  simultaneous, 24
picking items from D-Lists, 63
pivot tables, 29
pivot view
  creating, 29
printing
  assigning actions, 67
  batch, 62
  macros, 71
  printing reports, 43
R
ranges
  amending, 69
read/write access, 62
recalculating, 13
  allowing breakback, 55
  allowing breakback from Microsoft Excel formulas, 55
  all views, 60
  assigning action, 67
  selected view, 13
  selected views, 60
refresh
  active D-Cube view, 59
  all views, 59
  D-Cube views, 59
  on loading, 62
Index

partial, 59
views, 25, 37
views on loading, 58
views with latest values, 59
refresh command, 59
refreshing
assign action, 67
releasing read/write access, 62
releasing write access
assigning actions, 67
renaming
D-Cubes, 66
D-Links, 66
D-List items, 39
libraries, 66
macros, 66
systems, 66
reordering
D-Lists, 37
replacing
D-Cube names, 38
object names in all definitions, 66
replicating headings, 53
reports
printing, 43
reselect
view command, 61
reset D-Cube
command, 61
partial resetting, 13
resetting, 13
resizing drop-down menus, 65
rows
defining, 45
deleting, 36
errors, 18, 50, 69
inserting, 36, 39
laminated, 69
renaming, 39
selecting, 11, 17
sorting, 40
suppressing zeros, 53
updating from D-Lists, 18, 50
running D-Links, 26, 63
assigning actions, 68
running macros, 63
assigning actions, 68
S
save D-Cube command, 61
saved selection, 18
create new view, 18
saving
assigning actions, 67
D-Cubes, 15
Microsoft Excel report, 15
view, 13
scrolling
simultaneous, 24
select existing pages
batch printing, 40
selecting
rows, columns, pages, 11, 17
sharing pages, 24, 70
sheets
printing, 62
showing precedents of formulas, 66
sorting
D-List items, 40
rows, columns, pages, 40
suppressing zero rows, 53
systems
renaming, 66
T
text
replacing in definitions, 66
U
updating labels, 38
V
version numbers, 68
view options
accessing, 49
allow break-back from Microsoft Excel formula
breakback, 55
allow break-back on recalculate, 55
blank invalid data cells if note present, 56
check for incomplete totals, 57
check for unmatched items, 56
get write access on loading, 58
overwrite Microsoft Excel formula on refresh, 56
refresh view on loading, 58
replicate headings, 53
suppress zero rows on refresh, 53
treat blank cells as zero, 54
treat errors as zero on recalculate, 55
views
allowing breakback from Microsoft Excel formulas, 55
allowing breakback on recalculating, 55
blank invalid data cells, 56
copying, 63
creating new, 11, 40
default options, 68
defining, 45, 64
deleting, 64
Hierarchical, 31
multiple views, 23
new, 63
overwriting Microsoft Excel formulas, 56
Pivot Table, 29
recalculating, 60
refresh, 59
refreshing, 25, 37
refreshing on loading, 58
rese lecting, 61
resizing drop-down menus, 65
treating errors as zero, 55
Visual Basic commands, 71
W
write access, 62
Z
zeros
suppressing zero rows, 53
zeroing out invalid cells, 56